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Hot Fix Descriptions as of October 17, 2014 

Hot Fixes are all installed on the Web/Application Tier unless otherwise mentioned. 

 

Hot fixes are intended to be installed only if your Vision software is experiencing the symptom 
described. 

Hot Fix #001 (July 12, 2013) Removed. Included in Cumulative 
Hot Fix #029 

Accounting/Accounts Payable 

Defect Tracking Number: 374996 

Description: An Accounts Payable payment run may fail with a non-recoverable error if you use 
the Multicurrency feature and you are paying a foreign denominated voucher in full.  

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: The error will occur only when a gain or loss is applied at the time of the full 
payment, either to draw the functional currency balance to zero, and/or to reverse any unrealized 
gains/losses previously booked. 

Files Updated  
Deltek.Vision.APPaymentProcess.Server.dll 

Other Applications Affected  

System File Dependencies  

Payment Processing 

Defect Tracking Number: 375756 

Description: If you use the Multicurrency feature and you ran the Undo Posting advanced utility 
to undo an Accounts Payable Payment Processing posting, the payment amount that was 
removed for vendors (in the Paid This Year field in the Vendor Info Center) was incorrectly based 
on the check payment currency instead of the functional currency of the company that issued the 
payment if these two currencies were different. 

Impact: This defect applies to Vision 7.0 SP1. 

Workaround: Manually update the Paid This Year field in Vendor Info Center.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.PostingUndo.Server.DLL 

Other Applications Affected  

System File Dependencies  

Revenue/Revenue Generation 

Defect Tracking Number: 379697 
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Description: When you ran Revenue Generation and you created a journal entry file and 
manually posted it instead of having it post automatically as generated, it incorrectly posted a 
project currency revenue amount.  

Impact: This defect applies to Vision 7.0 SP1 and later. 

Workaround: Post the revenue as it is generated.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.Posting.Server.dll 

Other Applications Affected  

System File Dependencies  

Analysis Cubes 

Defect Tracking Number: 377841 

Description: If you have a non-United States English Vision database and you do not have the 
Performance Management or the Performance Management Analysis Cubes edition of 
Performance Management installed, all the project data cube measures were set to invisible.  

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround:  None.  

Additional Notes: None. 

Files Updated  
DeltekVisionResourceKit.exe 
DeltekVisionHelper.dll 

Other Applications Affected  

System File Dependencies  

API (VisionXtend) 

Defect Tracking Number: 378073 

Description: In applications that utilize Vision APIs, the currency code for transaction detail for 
miscellaneous expenses was not being validated to ensure that it matched the currency code 
entered for an account in the Vision Chart of Accounts.  

Impact: This defect applies if you use the Multicurrency feature and VisionXtend in Vision 6.2 
SP2 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
ValidationInfo.xml 

Other Applications Affected  

System File Dependencies  

Billing 

Defect Tracking Number: 374112 
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Description: If the billing terms for a project were set up with Enable Posting by Billing Phase 
and Allocate Billed Revenue on Fee Invoices Based on Transaction Detail selected, and there 
were multiple billing phases posting to the same work breakdown structure element, the billed 
revenue was not allocated correctly on the Invoice Accept dialog box when you accepted the 
invoice, though the overall totals were correct. This problem does not affect the invoice itself, only 
the data displayed in the Invoice Accept dialog box.  

Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.Billing.Server.dll 

Other Applications Affected  

System File Dependencies  

Connect for Microsoft Outlook 

Defect Tracking Number: 376581 

Description: In Connect for Microsoft Outlook, when you added a new primary address for a 
client that already had a primary address, you received an error when you synchronized. Now, 
you no longer receive the error. The new primary address is accepted as the new primary 
address, and the old primary address is retained in Vision but not as the primary address. 

Impact: This defect applies to Vision 6.2 SP2 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ClientInfoCenter.Server.dll 

Other Applications Affected  

System File Dependencies 

Defect Tracking Number: 376583 

Description: When you added a new client in Connect for Microsoft Outlook and you did not 
have the Vision Accounting module installed, the client address fields in Vision were not enabled 
for the client after you synchronized.  

Impact: This defect applies to Vision 6.2 SP2 and later versions of Connect for Microsoft Outlook. 

Workaround: Run a script to set Billing to "N" each time after the synchronization.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Configuration 

Defect Tracking Number: 379228 
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Description: When the CRM Module was not in use, the Mobile CRM option continued to display 
in  Configuration » General » User Defined Components. When an item was added, deleted, or 
modified, the following error displayed: Column named MobileCRMSection not found. 

Impact: This issue applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.SetupCustomTabs.Client.dll 

Other Applications Affected  

System File Dependencies  

Workflow 

Defect Tracking Number: 375757 

Description: The Workflow process did not update fields with [null] values correctly.  

Impact: This defect applies to Vision 7.0 SP1 and later releases.  

Workaround: You can have a default value populate the field instead of leaving it blank.  

Additional Notes: None. 

Files Updated 
Deltek.Vision.ApplicationAncestors.Server.dll 

Other Applications Affected  

System File Dependencies  

Dashboard 

Defect Tracking Number: 376597 

Description: The following error occurred when you tried to load the Dashboard: Invalid Object 
name 'CFGDSPURL'  

Impact: This defect applies to Vision 7.1 and later releases.  

Workaround: Remove the DSP URL from Weblink before you upgrade to 7.1.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.Syslogin.Server.dll 
Deltek.Vision.Dashboard.Server.dll 
Deltek.Framework.Syslogin.Server.dll 

Other Applications Affected  

System File Dependencies  

Human Resources/Payroll 

Defect Tracking Number: 365531 

Description: State withholding did not calculate accurately for Alabama, Iowa, Missouri, or 
Oregon when the setup included the following two conditions:  
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� The filing was for an employee who was using Locale Method that was followed by either 
a project or percent of wage. 

� The filing included “Other” types of withholdings with sequence numbers that were listed 
before the Federal withholding. 

Impact: This defect applies to Vision 7.0.  

Workaround: None. 

Additional Notes: None.  

Files Updated  
Deltek.Vision.PayrollBO.Server.dll 

Other Applications Affected  

System File Dependencies  

Planning 

Defect Tracking Number: 374840 

Description: When the Create New Plan from Existing Project option was selected, and the new 
plan was merged with a template that contained generic resources, the generic resources were 
dropped from the new plan.  

Impact: This defect applies to Vision 7.0 and later releases.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.PlanProjOpp.Server.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Payroll 

Defect Tracking Number: 374837 

Description: The Payroll Posting Log for Payroll Journal FICA and Medicare amounts did not 
match the GL.  

Impact: This defect applies to Vision 7.1 and later releases.  

Workaround: The Payroll Posting Log displays the correct value (twice the amount of employee 
portion from payroll journal). The Payroll Journal's employer portion is only a reference, not the 
actual total that is posted to GL. When a client is reporting based on GL, they are using the 
correct amount.  

Additional Notes: None. 

Files Updated  
PayrollJournalWithholdingsSummary.rdl 

Other Applications Affected  

System File Dependencies  

Project 

Defect Tracking Number: 376732 
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Description: If you selected Project Baseline Budget or Project Planning Budget in Budget 
Source on the Budget & Expense tab of the Options dialog box for the Project Summary report, 
the Percent Complete Reported (% Cmp Rpt) column was blank when you generated the report. 

Impact: This defect applies to Vision 7.0 and later versions.  

Workaround: None. 

Additional Notes: None. 

Files Updated  
Project Summary.rdl 

Other Applications Affected  

System File Dependencies  

Time and Expense/Timesheet 

Defect Tracking Number: 255673 

Description: When you used the Start/End Time feature for Timesheets and you selected the 
Page Break by Project option when you previewed the detailed or summarized timesheet reports, 
the reports did not have a page break between projects as it should have. 

Impact: This defect applies for Vision 6.1 SP4 and later. 

Workaround: None. 

Additional Notes: You enabled the Start/End Time feature on the Setup tab in Configuration » 
Time & Expense » Company Timesheet. On the Time tab in the Employee Info Center, you 
enable the setting to require employees to enter timesheet start and end times.  

Files Updated  
SummaryTimesheet.rdl 
Timesheet Start End.rdl 
Timesheet.rdl 

Other Applications Affected  

System File Dependencies  

Regulatory Updates  

Minnesota Tax Withholding 

Defect Tracking Number: 377797 

Description: Minnesota added a fourth withholding amount of 9.85%, applicable to:  

� Filing status of Single, with income more than $152,200 

� Filing status of Married, with income more than $256,250 

North Dakota Tax Withholding  

Defect Tracking Number: 379460 

Description: North Dakota has updated its tax withholding, as follows:  

� Income tax rates for single and married statuses are updated. 

� Supplemental tax decreased from 2.82% to 2.28%. 
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Wisconsin SUTA Electronic Filing 

Defect Tracking Number: 372525 

Description: Wisconsin has updated its SUTA Electronic Filing as follows: 

� Social Security Number—(POS 14-22): Previously, this field was blank-filled if no social 
security number was available. Now, fill this field with zeroes (0) if no social security 
number is available. 

Human Resources\Payroll  

Defect Tracking Number: 372861 

Description: To allow financial institutions to see a payer's address and phone number when 
check stubs are presented as documentation of wages, the payer’s name, address, and phone 
number have been added to payroll check stubs. This payer information has been added only for 
previewed checks, printed checks, and emailed remittances when employees are paid by 
electronic fund transfers (EFT). The payer information is located below the earnings row and 
above the bank name from which the payments are being made. The payer's address and phone 
number are retrieved from the Form W-2 Processing form in Human Resources » Payroll » Form 
W-2 Processing. A new Phone field was added to the Employer's address section on the Form 
W-2 Processing form. 

GovWin Capture Management 

Deltek Tracking Number: 376355 

Description: On the GovWin Capture Management main toolbar, the GovWin Input icon has 
been renamed to GovWin IQ. The GovWin IQ icon and the GovWin.com icon now open the same 
new login page (https://govwin.com/member/login). On this page, you choose whether to log in to 
GovWin IQ or GovWin. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix.  

Cumulative Hot Fix #002 (July 26, 2013) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and that Hot Fix has been 
removed. However, if you previously installed that Hot Fix, it will still show up in the About Deltek 
Vision dialog box as being installed. For a description on what was fixed in the hot fix that 
was consolidated into #002, please review its description above in this document. 

Vision 

Deltek Defect Tracking Number: 380165 

Issue Resolved: If you use Connect for Microsoft Outlook and you added a new address for an 
existing client in Outlook and made it the primary address, when you synchronized Connect for 
Microsoft Outlook, it was not flagged as the primary address for the client in the Vision Info 
Center.  
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Impact: This defect applies to Vision 7.0 and later versions of Connect for Microsoft Outlook.  

Workaround: In the Vision Info Center, select the Primary check box for the address.  

Additional Notes: None. 

Files Updated: 
Deltek.Vision.ClientInfoCenter.Server.dll 

Other Applications Affected  

System File Dependencies  

API 

Deltek Defect Tracking Number: 380007 

Issue Resolved: If you use VisionXtend and you used the GetRecordsByQuery API with 
Transaction Data Entry or User Defined Info Center (UDIC), it incorrectly required that your user 
role have "Full access to all menu items." 

Impact: This defect applies to Vision 7.0 SP1 and later versions of VisionXtend.  

Workaround: Use a user ID with full access to all menu items. 

Additional Notes: None. 

Files Updated:  
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Connect for Microsoft Outlook 

Deltek Defect Tracking Number: 379679 

Issue Resolved: When Vision activities with read only access rights were synchronized and 
uploaded into Outlook, you received an error the next time you synchronized Connect for 
Microsoft Outlook.  

Impact: This defect applies to Vision 6.2 SP2 and later. 

Workaround: 

Additional Notes: None. 

Files Updated: 
CMO 1.2.1.3 

Other Applications Affected  

System File Dependencies  

Configuration/Security/Roles 

Deltek Defect Tracking Number: 377809 

Issue Resolved: Even though the Resource Planning module was not licensed, the Project Plan 
row continued to display on the Record Access tab in Vision Security.  

Impact: This issue applies to Vision 7.1.  

Workaround: None.  

Additional Notes: None. 
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Files Updated: 
Deltek.Vision.SecRoles.Client.dll 

Other Applications Affected  

System File Dependencies  

Deltek Defect Tracking Number: 377810 

Issue Resolved: Some of the Navigator fields did not display correctly when switching to the List 
view in Configuration » Security »  Roles.  

Impact: This issue applies to Vision 7.1 and later releases.  

Workaround: None.  

Additional Notes: None. 

Files Updated:  
Deltek.Vision.SecRoles.Client.dll 

Other Applications Affected  

System File Dependencies  

Dashboard 

Deltek Defect Tracking Number: 378868 

Issue Resolved: When you added a web dashpart for the "Executive Sample - Opportunity Wins 
and Projections" Performance Management dashboard, the value for the "Opportunity Sales 
Target No Dimension Goal" KPI was incorrect. The value should have been the same as the 
default value set up in Analysis Cubes Configuration. 

Impact: This defect applies if you use Vision 7.1 Performance Management dashboards.  

Workaround: None.  

Additional Notes: None. 

Files Updated:  
Wokbooks\Executive Sample - Opportunity Wins and Projections.twb 

Other Applications Affected  

System File Dependencies  

Info Center/Employees 

Deltek Defect Tracking Number: 382680 

Issue Resolved: The Advanced Search feature on the Employee Info Center grid produced 
incorrect results.  

Impact: This issue applies to Vision 7.0 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated: 
deltek.framework.lookup.server.dll 
deltek.framework.lookup.client.dll 

Other Applications Affected  
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System File Dependencies  

Navigator 

Deltek Defect Tracking Number: 379505 

Issue Resolved: The WBS structure that was configured in Vision Planning was not applied to 
projects in Navigator.  

Impact: This issue applies to Vision 7.1 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated:  
Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected  

System File Dependencies  

Performance Management Canvases 

Deltek Defect Tracking Number: 382106 

Issue Resolved: You received an error when you tried to view a Vision Performance 
Management workbook that had special characters in the URL. 

Impact: This defect applies to Vision 7.1. 

Workaround: Replace the special characters with their URL encoded format (for example, 
replace & with %26; use Google to search for the character's URL encoded form.) 

Additional Notes: None. 

Files Updated: 
Deltek.Vision.Dashboard.Client.dll 
Deltek.Vision.Dashboard.Server.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Project 

Deltek Defect Tracking Number: 376731 

Issue Resolved: If you generated the Office Earnings report using a presentation currency, the 
report displayed different results in the Spent column when you used the Project Summary table 
than it did when you did not use that table. The amounts displayed when you used the Project 
Summary table were incorrect. 

Impact: This defect applies to customers who use the Multicurrency feature in Vision 6.1 SP4 
and later versions. 

Workaround: Do not run the report using the Project Summary tables.  

Additional Notes: None. 

Files Updated:  
Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected  

System File Dependencies  
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Transaction Center 

Deltek Defect Tracking Number: 380245 

Issue Resolved: An intercompany charge was entered and posted using a General Ledger 
account that was available to the company that entered the expense, but not available to the 
company that received the expense.  

Impact: This issue applies to Vision 7.0 SP1 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated:  
Deltek.Vision.Expensekeeper.Client.dll 

Other Applications Affected  

System File Dependencies  

Software Enhancements  

Reporting/ General Ledger  

Deltek Tracking Number: 366634 

Description: 

You can now print a balance sheet and an income statement showing account groups that have a 
zero balance. To support this feature, a Print Account Groups with Zero Balance check box has 
been added to the General tab on the report options dialog box for the following reports: Balance 
Sheet, Income Statement, Consolidated Balance Sheet, and Consolidated Income Statement. 
This check box is available only when you select an account table in the Group Table field on the 
General tab. This feature is designed to run with the Account Group selected as the first or 
second sort level (after Account Type) on the Sorting/Grouping tab of the report options dialog 
box. When you select the Print Account Groups with Zero Balance check box, all detail account 
group names and summary account group names within the selected account groups will display 
on the report. 

This feature was added primarily so that European firms that use Vision can print a balance sheet 
and an income statement that show account groups that have a zero balance, a legal 
requirement for producing financial statements. 

Files Updates: 
Deltek.Vision.ReportingGeneralLedger.Client.dll  
Deltek.Vision.ReportingGeneralLedger.Server.dll 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix.  
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Cumulative Hot Fix #003 (August 9, 2013) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #002 and that Hot Fix 
has been removed. However, if you previously installed that Hot Fix, it will still show up in the 
About Deltek Vision dialog box as being installed. For a description on what was fixed in the 
hot fix that was consolidated into #003, please review its description above in this 
document. 

Accounting/Employee Expenses/Payment Processing 

Defect Tracking Number: 383425 

Description: You received an error message when you processed an expense report payment 
that had a net zero or negative amount.  

Impact: This defect applies to Vision 7.1. 

Workaround: If possible, make the payment with another expense report that will bring the net 
greater than zero.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.EMPaymentProcess.Client.dll 

Other Applications Affected  

System File Dependencies  

Revenue/Revenue Generation 

Defect Tracking Number: 379704 

Description: You received an error when you ran Revenue Generation if a project was dormant 
and had invoices that totaled to zero.  

Impact: This defect applies to Vision 7.0 SP1 and later. 

Workaround: Set the revenue method to None for the project (at the appropriate work 
breakdown structure level). 

Additional Notes: None. 

Files Updated  
Deltek.Vision.RevenueGeneration.Server.dll 

Other Applications Affected  

System File Dependencies  

Billing/Batch Billing 

Defect Tracking Number: 384338 

Description: When you generated invoices in Batch Billing, invoices with more than one page 
displayed the correct invoice number on the first page but displayed the invoice number of the 
first invoice in the batch on subsequent pages. 

Impact: This defect applies to Vision 7.1. 

Workaround: None. 
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Additional Notes: None. 

Files Updated  
Deltek.Vision.Billing.Server.dll 

Other Applications Affected  

System File Dependencies  

Help 

Defect Tracking Number: 383215 

Description: The “Welcome to the Deltek Vision Help System” topic, the first topic that you see 
when you open the online Help in Vision, now contains a link to the Vision 7.1 Online Help 
Updates documentation (DeltekVision71EnhancementsOnlineHelp.pdf). This file contains the 
new and updated help topics for the 7.1 enhancements. The online Help in Vision 7.1 is the Help 
from Vision 7.0 SP1 and does not include the new 7.1 help. We are currently in the process of 
converting to a new Help system that uses a new robust tool that will allow Deltek to update the 
Help constantly to provide you with the most current and accurate Vision Help system that is 
easier to navigate and use. The "Welcome to the Deltek Vision Help System” topic also has a link 
to the Vision 7.1 Release Notes.  

Impact: This applies to all Vision 7.1 users. 

Workaround: None. 

Additional Information: In addition to accessing the Vision 7.1 Enhancements Online Help PDF 
file from the “Welcome to the Deltek Vision Help System” topic in Vision, you can also download 
the file from the Deltek Customer Care Connect site from Knowledge Base article 74449 or from 
the Deltek Software Manager (DSM) when you download the 7.1 software. 

Files Updated  
WelcomeTopic.htm 

Other Applications Affected  

System File Dependencies  

Navigation Tree 

Defect Tracking Number: 382267 

Description: Even though FILESTREAM was enabled in Weblink, the Files Administration menu 
was not available to Roles that had Full Access to all menu items.  

Impact: This issue aplied to Vision 7.1. 

Workaround: None.  

Additional Notes: None. 

Files Updated  
navigationMenu.xml 

Other Applications Affected  

System File Dependencies  

Navigator 

Defect Tracking Number: 381132 
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Description: Navigator populated an invalid labor code when the labor code 
delimiter(CFGFormat.LCDelimiter) was set to NULL.  

Impact: This defect applies to Vision Navigator.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected  

System File Dependencies  

Performance Management Canvases 

Defect Tracking Number: 382343 

Description: When you logged on to Vision and did not have an Employee record in Vision, you 
would not be able to add or view Performance Management workbooks that had the org-is-mine 
auto filter. 

Impact: This defect applies to Vision 7.1. 

Workaround: Either temporarily associate the login user to an employee, or get the workbook's 
URL, remove the query string for the org-is-mine auto filter, and then use the amended URL to 
add a URL dashpart. To get the workbook’s URL, click the down arrow beside the dashpart name 
in the upper left corner of the dashpart heading, and then click Open in New Window. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.Dashboard.Server.dll 

Other Applications Affected  

System File Dependencies  

Utilities 

Defect Tracking Number: 381616 

Description: During the database merge process, you received a Framework Exception error 
("Violation of PRIMARY KEY constraint 'FW_CFGUserSettingsDataPK'. Cannot insert duplicate 
key in object 'dbo.FW_CFGUserSettingsData'...") if the two databases contained the same User 
Settings record. 

Impact: This defect applies to Vision 7.0 SP1 and later. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ImportUtility.Server.dll 

Other Applications Affected  

System File Dependencies  
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CONNECT FOR MICROSOFT OUTLOOK 

 Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix.  

Cumulative Hot Fix #004 (August 23, 2013) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #003 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #004, please review their descriptions above in 
this document. 

Vision 

Deltek Defect Tracking Number: 385127 

Issue Resolved: If the Project Info Center or a user-defined Info Center has the auto numbering 
feature enabled, when you added records to them through VisionXtend using the 
[AUTONUMBER] option, you received an error.  

Impact: This defect applies to VisionXtend 6.2 SP2 and later versions. 

Workaround: None. 

Additional Notes/Comments: None. 

Files Updated: 
Deltek.Vision.ApplicationAncestors.Server.dll 
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected:  

System File Dependencies:  

API 

Deltek Defect Tracking Number: 383957 

Issue Resolved: User-initiated workflows (dashboard or email alerts) that should have been 
triggered when new Info Center records were added to Vision were not triggered if the records 
were entered and saved using a VisionXtend Web Service API. 

Impact: This defect applies if you use VisionXtend 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes/Comments: None. 
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Files Updated: 
Deltek.Vision.ApplicationAncestors.Server.dll 
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected:  

System File Dependencies:  

Billing / Interactive Billing 

Deltek Defect Tracking Number: 384851 

Issue Resolved: If your Vision database is a non-Unicode database and if you included the 
Billing Backup report in the invoice and expenses were displayed, it took much too long to display 
an invoice when you previewed it in Interactive Billing. 

Impact: This defect applies to Vision 6.1 SP4 and later versions 

Workaround: None. 

Additional Notes/Comments: None. 

Files Updated:  
backupExpense.rdl 
backupConsultant.rdl 

Other Applications Affected:  

System File Dependencies:  

Configuration / General / Alerts 

Deltek Defect Tracking Number: 382946 

Issue Resolved: If an Accounts Receivable alert has two rules with "Send When = "Client's 
Balance,"" and the two rules cover only some (but not all) projects, then the second rule did not 
get processed because the query was not refreshed. 

Impact: This defect applies to Vision 6.0 and later versions.  

Workaround: Resubmit the queue job until all rules are processed.  

Additional Notes/Comments: None. 

Files Updated:  
Deltek.Vision.Alerts.Server.dll 

Other Applications Affected:  

System File Dependencies:  

Security / Roles 

Deltek Defect Tracking Number: 385415 

Issue Resolved:  An error occurred when a new role was created and saved.  

Impact:  This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes/Comments: None. 

Files Updated:  
Deltek.Vision.SecRoles.Client.dll 
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Other Applications Affected:  

System File Dependencies:  

Deltek Defect Tracking Number: 385545 

Issue Resolved:  An error displayed when the Same as Vision Project Planning Record Level 
Update option was selected on the Navigator tab in Security.  

Impact:  This defect applies to Vision 7.1 and later versions. 

Workaround:  None. 

Additional Notes/Comments:  None. 

Files Updated:  
Deltek.Vision.SecRoles.Client.dll 

Other Applications Affected:  

System File Dependencies:  

Utilities / Process Server 

Deltek Defect Tracking Number: 385353 

Issue Resolved: The Event Log tab of the Process Server Management form displayed no log 
entries. 

Impact: This defect applies to Vision 7.0 SP1 

Workaround: None. 

Additional Notes/Comments: None. 

Files Updated:  
Deltek.Framework.EventLog.Server.dll 
Deltek.Vision.Ancestors.Server.dll 

Other Applications Affected:  

System File Dependencies:  

Regulatory Updates  

State of Ohio / Ohio Withholding Tax 

The Ohio withholding tax tables have been updated to reflect the reduced individual income tax 
rates (10 percent reduction over three years), effective September 1, 2013. This is per the 
recently passed legislation HB 59. 

CONNECT FOR MICROSOFT OUTLOOK 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
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application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix #005 (September 6, 2013) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #004 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #005, please review their descriptions above in 
this document. 

Analysis Cubes 

Defect Tracking Number: 386549 

Description: If you have a non-United States English Vision database and you do not have the 
Performance Management or the Performance Management Analysis Cubes edition of 
Performance Management installed, all the project data cube measures were set to invisible.  

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround:  None.  

Additional Notes: None. 

Files Updated  
DeltekVisionResourceKit.exe 
DeltekVisionHelper.dll 

Other Applications Affected  

System File Dependencies  

Enhancements  

Role Summary Report Configuration 

Description: The Role Summary report presents detailed information for each role created for 
Vision users. To specify the contents of the Role Summary Report, you can select the options 
that you want to display. The Report Sections to Include group box includes a Navigator option 
that you can select to include Navigator information on the report. This option is not selected by 
default. 

Files Updated  
roleNavigatorSection.rdl 
Role Summary.rdl 
roleInfoCentersSection.rdl 
Deltek.Vision.ReportLabels.Server.dll 
Deltek.Vision.ReportingConfiguration.Client.dll 
Deltek.Vision.ReportingConfiguration.Server.dll  

CONNECT FOR MICROSOFT OUTLOOK 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 
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Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix #006 (September 23, 2013) Removed. 
Included in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #005 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #006, please review their descriptions above in 
this document. 

Vision 

Defect Tracking Number: 388059 

Description: General Ledger reports that normally run in a minute or less took ten minutes or 
more. This performance problem occurred because pre-defined groups in the RDL's dataset 
caused a series of errors when there was no corresponding data in the query. The errors appear 
in the reporting services log file and are similar to the following: 

processing!ReportServer_0-50!1b68!08/07/2013-12:05:00:: e ERROR: Throwing 
Microsoft.ReportingServices.ReportProcessing.ReportProcessingException: , 
Microsoft.ReportingServices.ReportProcessing.ReportProcessingException: There is no data for 
the field at position 7. 

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: You can work around this defect by modifying the rsreportserver.config file to 
disable the Watson logging: 

1. Run Notepad as an administrator, open the rsreportserver.config file, and find the 
following settings: 

<!-- <Add Key="ProcessTimeout" Value="150" /> --> 

<!-- <Add Key="ProcessTimeoutGcExtension" Value="30" /> --> 

<!-- <Add Key="WatsonFlags" Value="0x0430" /> full dump--> 

<!-- <Add Key="WatsonFlags" Value="0x0428" /> minidump --> 

<!-- <Add Key="WatsonFlags" Value="0x0002" /> no dump--> 

<Add Key="WatsonFlags" Value="0x0428"/> 

2. Change <Add Key="WatsonFlags" Value="0x0428"/> to <Add Key="WatsonFlags" 
Value="0x0002” />. 

3. Restart reporting services. 

This is a temporary workaround. It effectively prevents any crash dumps from occurring until 
Microsoft can identify the problem and provide a fix. 

Additional Notes: None. 

Files Updated  
Account Analysis.rdl 
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Balance Sheet.rdl 
Income Statement.rdl 
Deltek.Vision.ReportingGeneralLedger.Server.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 388942 

Description: In applications that utilize VisionXtend APIs, you received an error message when 
you added or updated an Info Center record that included information from Vision database 
tables other than the main Info Center table (for example information from the EMProjectAssoc 
table for Projects).  

Impact: This applies to VisionXtend 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 388946 

Description: Performance has been improved when project compensation, consultant fee, and 
reimbursable allowance amounts are compiled up from the task level to the phase and project 
levels in various places throughout the software. 

Impact: This issue applies to Vision 6.1 SP4 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
DeltekVision71GAHotFix006.sql 

Database Changes  

Object Updated: UpdatePRFees stored procedure 

Other Applications Affected  

System File Dependencies  

Billing/Interactive Billing 

Defect Tracking Number: 385401 

Description: You received an error when you tried to transfer multiple consultant expenses 
across companies using Interactive Billing.  

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: Both the posting log and the Project Detail report indicate that the first line 
item was transferred but that the other line items were not. In Interactive Billing, it appears that 
the tranfer did not occur for any of the line items. 
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Files Updated  
Deltek.Vision.Billing.Server.dll 

Other Applications Affected  

System File Dependencies  

Configuration/Security 

Defect Tracking Number: 388696 

Description: When Windows Authentication was in use, the Windows Authentication option was 
not automatically selected in the Vision login dialog box. This should be selected when an attempt 
to log in is made after clicking the Forgot your password or User ID? link.  

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Framework.Frame.Client.dll 
Deltek.Vision.FrameUI.Client.dll 
Deltek.Vision.Globals.Common.dll 
Deltek.Vision.SysLogin.Server.dll 

Other Applications Affected  

System File Dependencies  

Utilities/Process Server 

Defect Tracking Number: 386356 

Description: The process server did not delete sessions after processing was completed, and 
manually deleting old sessions caused database deadlocks.  

Impact: This defect applies to Vision 7.0 SP1 or later versions for all SaaS customers and for 
non-SaaS customers running multiple process servers. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Framework.Ancestors.Server.dll 
Deltek.Framework.ProcessServer.Server.dll 

Deltek.Framework.SysLogin.Server.dll 

Database Changes  

Inserted a new Process Server job to Delete Old Sessions from the Session State database 

Other Applications Affected  

System File Dependencies  

VisionXtend 

Deltek Tracking Number: 388927 
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Description: A new WebAPI.EnableWorkflow option has been added in web.config. It allows you 
to choose whether or not workflow will be triggered when you add or update Info Center records 
with VisionXtend APIs. For more information, see the Deltek VisionXtend 7.1 Web Services and 
APIs for Deltek Vision guide. 

Files Updated 
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected 

System File Dependencies 

Database Changes 

The following .SQL script (DeltekVision71GAHotFix006.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

CONNECT FOR MICROSOFT OUTLOOK 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix #007 (October 4, 2013) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #006 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #007, please review their descriptions above in 
this document. 

Accounting/Accounts Payable/Payment Processing 

Defect Tracking Number: 386974 

Description: This issue applies if you use the Multicurrency feature and you processed and 
posted a wire transfer or direct debit run in Accounts Payable Payment Processing. The Amount 
and Cash Basis Amount columns on the AP Payment Processing Posting log for a voucher did 
not match the amount in the Bank Total field in the Currency Converter section on the Vendor 
Review tab in A/P Payment Processing as it should have in the following scenario: You entered 
an A/P voucher with multiple voucher lines and changed the payment currency in the Currency 
Override dialog box in A/P Voucher Transaction Entry. In Accounts Payable Payment Processing, 
you entered an exchange rate in the Currency Converter section of the Vendor Review tab for the 
voucher. You processed and posted the voucher payment in Accounts Payable Payment 
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Processing. Although the amounts did not tie out correctly in this scenario, the payment issued for 
the voucher was correct. 

Impact: This issue applies if you use Vision 7.0 SP1 and later. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.APPaymentProcess.Server.dll 

Other Applications Affected  

System File Dependencies  

Calendar 

Defect Tracking Number: 384589 

Description: After you created a new activity type in Configuration » General » Code Tables, you 
could create an activity using the new code, and the activity displayed on your calendar. 
However, the activity did not appear on the calendar when you printed the calendar. 

Impact: This defect applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
ActivityCalendarDailySubreport.rdl 
ActivityCalendarMonthlySubreport.rdl 
ActivityCalendarWeeklySubreport.rdl 
ActivityCalendarWeeklySubreportWeekend.rdl 
Deltek.Vision.ReportingActivity.Client.dll 
Deltek.Vision.ReportingActivity.Server.dll 

Other Applications Affected  

System File Dependencies  

Info Center/Projects 

Defect Tracking Number: 385613 

Description: Modifying a field when the Project Info Center was set to List View resulted in an 
error.  

Impact: This defect applies to Vision 7.1 and later versions.  

Workaround: Modify fields while in the Tab View.  

Additional Notes: None. 

Files Updated  
Deltek.Framework.Controls.Client.DLL 

Other Applications Affected  

System File Dependencies  
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Defect Tracking Number: 387236 

Description: When opening and loading a saved search on the Advanced Search dialog, the 
lookup's search results incorrectly returned all matches even though the Display option was set to 
Project.  

Impact: This defect applies to Vision 7.1 and later versions.  

Workaround: Manually open the saved search, click the Search button and select all.  

Additional Notes: You can also select the search from the folder.  

Files Updated  
Deltek.Vision.Lookup.Client.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 390084 

Description: Vision generated an error message when a workflow was executed in the Project 
Info Center from the Grid View.  

Impact: This defect applies to Vision 7.1.  

Workaround: The record is updated even though the workflow generated an error.  

Additional Notes: None.  

Files Updated  
Deltek.Framework.Controls.Client.dll 

Other Applications Affected  

System File Dependencies  

Purchasing 

Defect Tracking Number: 389561 

Description: If you marked a purchase order as Final without first entering cost distributions for it, 
and you later entered the cost distributions when creating a voucher from the PO on the Create 
Voucher from Purchase Orders form, the purchase order was incorrectly marked as not billable, 
and the billing amount was set to 0.00.  

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: Enter cost distributions on the Purchase Order form before marking the PO as 
Final. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.CreateVoucherFromPO.Client.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GAHotFix006.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
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also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix #008 (October 18, 2013) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #007 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #008, please review their descriptions above in 
this document. 

Vision 

Defect Tracking Number: 390789 

Description: When you tried to publish a Vision Performance Management workbook that had 
Show Top N filtering applied, you received an "Error processing workbook..." error. 

Impact: This defect applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Framework.PerformanceDashboard.Server.dll 

Other Applications Affected  

System File Dependencies  

Architecture 

Defect Tracking Number: 393473 

Description: An error message displayed when the Username field included an embedded space 
in Configuration » Security» Users » New User. 

Impact: This issue applies to Vision 7.1. 

Workaround: Use Vision Authentication to set up new users instead of Windows Integrated 
Security. 

Additional Notes: None. 
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Files Updated  
Deltek.Vision.secUsers.Client.dll 

Other Applications Affected  

System File Dependencies  

Billing/Invoice Approvals 

Defect Tracking Number: 385759 

Description: Vision allowed you to submit an invoice for approval when there was nothing to print 
on the invoice and Print Invoices without Current Activity was not selected in Billing Terms for the 
project.  

Impact This defect applies to Vision 7.1. 

Workaround: None. 

Additional Notes: After you install this fix, Vision does not allow you to submit an invoice for 
approval in Interactive Billing if Print Invoices without Current Activity is not selected and there is 
no current activity and and no billed-to-date or AR information. However, if there is no activity but 
there is billed-to-date or AR information, you can submit the invoice. This also applies to Batch 
Billing, except that, in Batch Billing, an invoice that has no current activity but has billed-to-date or 
AR information is only submitted for approval if you select Always Print in Print Invoice Without 
Current Activity on the Main tab of the Batch Billing form. 

Files Updated  
Deltek.Vision.Billing.Server.dll 
Deltek.Vision.interactiveBilling.Client.dll 

Other Applications Affected  

System File Dependencies  

Configuration/General/Code Tables 

Defect Tracking Number: 394627 

Description: Dutch: When Vision was run with the Dutch language selected, the Insert and 
Delete buttons did not display on the header in the State/Provinces Code Table dialog box.  

Impact: This defect applies to Vision 7.1. 

Workaround: None.  

Additional Notes: After you install this fix, the up and down arrows display without the respective 
Move Up and Move Down text. These labels were removed for all languages.  

Files Updated  
Deltek.Vision.CodeTableMaint.Client.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 394628 

Description: Dutch: When Vision was run with the Dutch language selected, the Insert and 
Delete buttons disappeared after deleting a status from the Contract Status Code Table dialog 
box. 

Impact: This defect applies to Vision 7.1. 
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Workaround: Delete one Contract Status at a time.The buttons display again after you close and 
reopen the Contract Status dialog box.  

Additional Notes: After you install this fix, the up and down arrows display without the respective 
Move Up and Move Down text. These labels were removed for all languages.  

Files Updated 
Deltek.Vision.CodeTableMaint.Client.dll 

Other Applications Affected  

System File Dependencies  

Info Center/Employees 

Defect Tracking Number: 388429 

Description: The results of the final merged document did not follow the order that was 
determined in the Vision grid.  

Impact: This issue applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.Merge.Client.dll 

Other Applications Affected  

System File Dependencies  

Projects 

Defect Tracking Number: 376365 

Description: The last project record was not loading when you clicked the Back button or 
returned to the Project Info Center within the same login session.  

Impact:  This defect applies to Vision 7.1.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Framework.Navigation.Client.dll 

Other Applications Affected  

System File Dependencies  

Installation 

Defect Tracking Number: 393757 

Description: If you use Touch Time, you received a “Could not retrieve timesheet from server” 
error when you tried to open an in-progress timesheet or when you tried to create a new 
timesheet by copying one from the previous period. 

Impact: This defect applies to Vision 7.1 Touch Time. 

Workaround: None. 

Additional Notes: None. 
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Files Updated  
DeltekVision71CumulativeUpdate008.exe 

Other Applications Affected  

System File Dependencies  

Navigator 

Defect Tracking Number: 394220 

Description: When a Vision plan was converted to a Navigator plan, the planned bill and planned 
costs on the Expenses page were zeroed out.  

Impact: This defect applies to Navigator 1.6 and Vision 7.1.  

Workaround: None.  

Additional Notes: None. 

Database Changes: Objects Updated -- The sp_PNCopyPlanFromVision.sql and 
sp_RefreshVOPaidPeriod.SQL objects were udpated as a result of this hotfix.  

Files Updated  
DeltekVision71GAHotFix008.sql 

Other Applications Affected  

System File Dependencies  

Purchasing/Purchase Template Editor 

Defect Tracking Number: 374164 

Description: If Footer was selected in Location for an image on the Images tab of the Purchase 
Template Editor for a purchase order template, you received the following error when you tried to 
generate purchase order forms using that template: 'Object reference not set to an instance of an 
object.'  

Impact This defect applies to Vision 7.0 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingPurchasing.Server.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Billing 

Defect Tracking Number: 384551 

Description: When you previewed the Unbilled Detail and Aging report, the Final Totals row 
displayed in the correct location, just before the Report Summary (Billing) section. However, 
when you selected the Print Layout option on the toolbar in the Preview window, the Final Totals 
row displayed after the Report Summary (Billing) section.  

Impact: This defect applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 
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Files Updated  
Deltek.Vision.ReportingBilling.Server.dll 
Unbilled Detail and Aging.rdl 

Other Applications Affected  

System File Dependencies  

Project 

Defect Tracking Number: 390496 

Description: When you drilled down on year-to-date hours on the Office Earnings report, the 
Labor Detail drilldown report incorrectly displayed job-to-date hours instead of year-to-date hours. 

Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: Generate the Labor Detail report (Reporting » Project » Labor Detail) with YTD 
data to see the correct YTD hours. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 391904 

Description: If you previewed an Office Earnings report that included current, job-to-date, and 
year-to-date values for a user-defined field, and you used the Advanced Search option in the 
preview window, it appeared that the search results contained duplicate fields because "Current," 
"Job-to-Date," and "Year-to-Date" were missing from the names displayed for the user-defined 
field values. 

Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: For example, if the report contained a column for a user-defined Amount 1 
field, the search results grid included three columns labeled Amount 1. The names displayed for 
those columns should have been Current Amount 1, Job-to-Date Amount 1, and Year-to-Date 
Amount 1. 

Files Updated  
Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected  

System File Dependencies  

Transaction Center 

Defect Tracking Number: 342294 

Description: The Employee field was not editable on the Units form in the Transaction Center.  

Impact: This defect applies to Vision 7.1.  

Workaround: None.  

Additional Notes: None. 



Hot Fix Descriptions as of October 17, 2014 

 

Hot Fix List 30 

 

Files Updated  
Deltek.Vision.DataEntry.Client.dll 

Other Applications Affected  

System File Dependencies  

Utilities/Advanced Utilities/VO Paid Update 

Defect Tracking Number: 390116 

Description: The Refresh VO Paid Period utility took longer that it should to run when the 
database contained many vouchers.  

Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Database Changes 
Object Updated: RefreshVOPaidPeriod stored procedure 

Files Updated  
DeltekVision71GAHotFix008.sql 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GAHotFix008.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix #009 (November 1, 2013) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #008 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #009, please review their descriptions above in 
this document. 
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Accounting/Accounts Payable/Payment Processing 

Defect Tracking Number: 395287 

Description: Accounts Payable check payment processing took a long time to complete. 

Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.APPaymentProcess.Client.dll 
Deltek.Vision.APPaymentProcess.Server.dll 

Other Applications Affected  

System File Dependencies  

Billing/Interactive Billing 

Defect Tracking Number: 394265 

Description: If you did a partial transfer of a PWP voucher line in Interactive Billing for a voucher 
with an unpaid balance, it resulted in an incorrect payment amount in an automatic payment run. 
To prevent this problem from occurring, a message (see "Additional Notes" below) now displays 
to warn you of the consequences of making the partial transfer. The message also recommends 
alternative actions. Click No in the message box to cancel the transfer, or click Yes if you still 
want to make the transfer. 

Impact: This defect applies to Vision 6.1 SP4 and later versions. 

Workaround: Either modify the original voucher in Transaction Entry, or process a manual 
payment for the voucher. 

Additional Notes: Message text: "Warning: A partial transfer of this PWP voucher line will result 
in an incorrect payment amount in an automatic payment run. You should either modify the 
original voucher in transaction entry or process a manual payment for this voucher. Do you want 
to continue with this partial transfer?" 

Files Updated  
Deltek.Vision.interactiveBilling.Client.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 395770 

Description: This applies for projects that require invoice approvals. If you installed Vision 7.1 
Cumulative Update (Hot Fix) 008 and then performed an approval action for an invoice (such as 
submitting an invoice), you received an error when you later accepted the invoice.  

Impact: This defect applies to Vision 7.1, only after you install Vision 7.1 Cumulative Update (Hot 
Fix) 008. 

Workaround Before Fix: None. 

Additional Notes: 

Database Changes: Added an update to the InvoiceApproval.SubmitReturnString column to fix 
incorrect data values (if they exist). 
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Files Updated  
Deltek.Vision.Billing.Server.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Project 

Defect Tracking Number: 356271 

Description: In some cases, the Project Progress report contained blank pages when you 
displayed it in Print Layout mode in the Preview window or downloaded it as a .PDF file. 

Impact This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: Do either of the following: 

� Increase the Left Margin for First Column option on the Columns tab of the Options dialog 
box to 2.5in. Make sure this left margin, plus the widths of all the columns selected, is 7.5 
inches or less. 

� If you want to keep the left margin at less than 2.476 inches (default is 1.59), make sure 
sum of the widths of all the columns selected is between 5.6 and 5.748 inches. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 391906 

Description: When you generated the Project Detail report or the Project Progress report with 
Page Break By Project checkbox selected in the Options dialog box, the report did not have a 
page break after every project. 

Impact This defect applies to Vision 7.0 and later versions. 

Workaround: On the Sorting/Grouping tab of the Options dialog box, select the Page Break 
check box for Project Number. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected  

System File Dependencies  

Visualization 

Defect Tracking Number: 382739 

Description: After you upgraded to Vision 7.1, all Visualization reports had a "Panopticon 
Evaluation Version" watermark on them.  

Impact: This defect applies to Vision 7.1.  

Workaround: None. 
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Additional Notes: None. 

Files Updated  
DeltekVision.exe 

Other Applications Affected  

System File Dependencies  

Resource Kit 

Defect Tracking Number: 395397 

Description: If you are not using organizations in Vision, you received errors when you published 
the sample Vision Performance Management workbooks (performance dashboards). To correct 
this defect, the publishing process has been modified to not publish workbooks that require the 
presence of organizations. Those workbooks are listed below under "Additional Notes." 

Impact: This defect applies to customers using the Vision Performance Management Edition of 
Performance Management in Vision 7.1. 

Workaround: None. 

Additional Notes: If your database has no organizations, the following are no longer included 
when you publish the sample workbooks: 

� Organization Manager Sample - Days Outstanding Metrics 

� Organization Manager Sample - Project Status 

� Organization Manager Sample - Accounts Receivable Trending 

� Organization Manager Sample - Opportunity Wins and Projections 

� Organization Manager Sample - Pipeline Revenue 

� Organization Manager Sample - Charts at Cost 

� Organization Manager Sample - Charts at Billing 

� Organization Manager Sample - Profit Drilldown 

� Organization Manager Sample - Variance Drilldown 

� Resource Manager Sample - Pipeline Revenue 

� Resource Manager Sample - Opportunity Wins and Projections 

� Resource Manager Sample - Utilization and Realization 

Database Changes: Updated the AddDefaultKPI stored procedure. 

Files Updated  
DeltekVisionHelper.dll 
DeltekVisionResourceKit.exe 
sp_AddDefaultKPI.sql 

Other Applications Affected  

System File Dependencies  

Transaction Center/Transaction Entry and Transaction Posting 

Defect Tracking Number: 394435 

Description: Posted units were displayed as unposted with timesheet transactions. When the 
timesheets were reposted, duplicate unit transaction files were created and posted.  



Hot Fix Descriptions as of October 17, 2014 

 

Hot Fix List 34 

 

Impact: This defect applies to Vision 7.1.  

Workaround: To work around this issue, you must unpost the duplicate units that were already 
posted. In addition, you must continue to manually delete the duplicate unit transaction file (with 
the original TS PS# reference) before posting.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.PostingUndo.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GAHotFix009.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 010 (November 15, 2013) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #009 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #010, please review their descriptions above in 
this document. 

Accounting/Accounts Payable 

Defect Tracking Number: 396165 

Description: This applies for bank codes that have the User Defined format selected for the 
Export to Text Format check payment setting on the Bank Codes tab in Configuration » 
Accounting » Banks. The date format that you entered on the User Defined File Format tab in 
Bank Codes Configuration was not being followed for the file creation date in the text file when 
you processed an export-to-text payment.  

Impact This applies to Vision 7.1. 

Workaround: Manually edit the file.  



Hot Fix Descriptions as of October 17, 2014 

 

Hot Fix List 35 

 

Additional Notes: None. 

Files Updated  
Deltek.Vision.APPaymentProcess.Server.dll 
Deltek.Vision.EmpPaymentBO.Server.dll 

Other Applications Affected  

System File Dependencies  

Billing/Invoice Approvals 

Defect Tracking Number: 397565 

Description: Deadlocks sometimes occurred when multiple users were concurrently using Vision 
applications involved in the invoice submission and approval process. 

Impact: This defect applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Database Changes: Updated sp_CreateApproverTable.sql to include "SET TRANSACTION 
ISOLATION LEVEL READ UNCOMMITTED" before the select/drop table code to avoid 
deadlocks. 

Files Updated  
DeltekVision71GAHotFix010.sql 

Other Applications Affected  

System File Dependencies  

Configuration/Organization/General 

Defect Tracking Number: 397282 

Description: When Multicompany was enabled, the EnableMultiCompany script routines did not 
populate some database fields that should contain values. Those fields are listed under 
"Additional Notes."  

Impact: This defect applies to Vision 7.1.  

Workaround: None.  

Additional Notes: The following database fields were affected by this defect: 

� CFGTransAutoNumBank 

� CFGTransAutoNumType 

Files Updated  
DeltekVision71GAHotFix010.sql 

Other Applications Affected  

System File Dependencies  

Conversion 

Defect Tracking Number: 397440 

Description: If you configured dashparts to use saved searches in Vision 6.2 or earlier version, 
that search confguration was lost when you upgraded from Vision 6.2 to Vision 7.1. In the 
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Dashpart Configuration dialog box for those dashparts, Search Type was set to Records after the 
conversion, rather than to Saved Search. 

Impact: This defect applies to customers upgrading from Vision 6.2 to 7.1. 

Workaround: None. 

Additional Notes: None. 

Database Changes: Added the following sql into the 6.x to 7.x conversion script: UPDATE 
DashboardLookupOptions SET XML = 
REPLACE(xml,'CustomColumnValuesData','FW_CustomColumnValuesData') 

Files Updated  
DeltekVision71GAHotFix010.sql 

Other Applications Affected  

System File Dependencies  

Navigator 

Defect Tracking Number: 398252 

Description: When the Restrict Charge Companies option (Info Center » Project » Accounting) 
was selected for the lowest WBS level of a project, the user could not use the Project lookup in 
Navigator Timesheet to charge hours.  

Impact: This issue applies to Vision 7.1.  

Workaround  None.  

Additional Notes: None. 

Files Updated  
deltek.vision.visionservices.server.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Accounts Receivable 

Defect Tracking Number: 398041 

Description: When you tried to download an AR Statement report to the Comma-Separated file 
format, you received an error. 

Impact: This defect applies to Vision 7.0 and later version. 

Workaround: Download the report to Microsoft Excel. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingAccountsReceivable.Server.dll 

Other Applications Affected  

System File Dependencies  

Utilities 

Defect Tracking Number: 397315 
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Description: The Key Convert Banks, Key Convert Organizations, and Key Convert Reference 
Number Format utilities did not populate some database fields that should contain values. Those 
fields are listed below under "Additional Notes." 

Impact: This defect applies to Vision 7.1. 

Workaround: None. 

Additional Notes: The following database fields were affected by this defect: 

� Key Convert Banks utility: CFGTransAutoNumBank.BankCode  

� Key Convert Organization utility: CFGTransAutoNumBank.Company, 
CFGTransAutoNumType.Company 

� Key Convert Reference Number Format utility: 
CFGTransAutoNumBank.NextRefNoReceipts, 
CFGTransAutoNumBank.NextRefNoPayments, CFGTransAutoNumType.NextRefNo 

Files Updated  

DeltekVision71GAHotFix010.sql 

Other Applications Affected  

System File Dependencies  

Software Enhancements  

SEPA File Formats 

A new SEPA File Format field has been added to the SEPA File Format tab of the Bank Codes 
form in Configuration » Accounting » Banks. From the drop-down list in this field, you can select 
either pain.001.001.03 or pain.001.002.03. These formats are commonly used in European 
countries for payments made using an .xml file format.  

Files Updates: 

Deltek.Vision.BankCode.Client.dll 
Deltek.Vision.APPaymentProcess.Server.dll 
Deltek.Vision.EmpPaymentBO.Server.dll 
Deltek.Vision.ReportLabels.Server.dll 
Bank List.rdl 

Database Changes — Column Added: 

Table Name Column Name Data Type Description 

CFGBanks SEPAFormat int NOT NULL default (0) SEPA XML Format. Options 
are: pain.001.001.03 and 
pain.001.002.03. 

Database Changes  

The following .SQL script (DeltekVision71GAHotFix010.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 
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Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 011 (December 13, 2013) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #010 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #011, please review their descriptions above in 
this document. 

Info Center 

Defect Tracking Number: 398043 

Description: Conducting a search within a user-defined info center sometimes resulted in 
duplicate records within the results, or the interface hanging.  

Impact: This defect applies to Vision 7.1.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Framework.Lookup.Server.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 398047 

Description: When conducting a search on a user-defined info center lookup, the results list did 
not display the correct user-defined fields.  

Impact: This issue applies to Vision 7.1 and later versions.  

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Framework.Lookup.Server.dll 

Other Applications Affected  

System File Dependencies  
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Performance Management Canvases 

Defect Tracking Number: 398092 

Description: The Executive Sample - Project Status performance dashboard incorrectly had 
organization-is-mine, principal-is-me, and project manager-is-me filters applied automatically. 
That dashboard should not have any automatically applied filters. 

Impact: This defect applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Database Changes: Updated the AddDefaultFilter stored procedure, adding a new record for 
"Executive Sample - Project Status." 

Files Updated  
Deltek.Vision.Dashboard.Server.dll 
DeltekVision71GAHotFix011.sql 

Other Applications Affected  

System File Dependencies  

 

To review descriptions of the enhancements for the Navigator 1.7 and Touch 1.2 applications, 
please see each product’s release notes. These are included on the Documentation tab in the 
respective sub-release sections on Deltek Software Manager. 

Database Changes  

The following .SQL script (DeltekVision71GAHotFix011.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 012 (December 27, 2013) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #011 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #012, please review their descriptions above in 
this document. 
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Important Note: IF YOU USE VISION PAYROLL, DO NOT INSTALL THIS HOT FIX IF YOU 
HAVE NOT PROCESSED THE FINAL PAYROLL FOR 2013. This Hot Fix includes the 2014 tax 
updates. A second update will be released in early 2014 which will contain any additional state 
and federal changes. 

2013 Year-End Regulatory Updates  

 Federal Updates 
 State Updates  
 1099-MISC Form and 1099 Electronic Filing updates 
 Files Updated 

Federal Updates 

Federal Deferred Compensation and Social Security 

The following are the federal taxes for 2014. Changes are in bold. 

Social Security Withholding 

 Social Security Employee Percent: 6.20% 

 Social Security Employer Percent: 6.20% 

 Social Security Wage Base: $117,000 

Medicare Withholding 

 Medicare Limit: No limit 

Medicare Employee Percent: 1.45%. Effective 2013, the Medicare tax on employee 
wages greater than $200,000 is 2.35%. 

 Medicare Employer Percent: 1.45% 

401(k), 403(b) Limits 

 401(k) Contribution Limit: $17,500 

 401(k) Wage Limit: $260,000 

 Catch-Up Contribution Limit: $5,500 

Federal Tax Withholding 

 2014 Allowance Amount: $3,950 

2014 Supplemental Flat Tax Rate for Wages Greater than $1 Million: The mandatory flat-
rate withholding remains at 39.6% for supplemental wages greater than $1 million. 

The rate for optional flat-rate withholding on supplemental wage payments remains 
at 25 percent. 

 2014 Nonresident Alien Tax Withholding: $2,250 

Federal Electronic File Update (Federal Mag Media) 

These are the changes in federal magnetic media for 2013 W-2s. 

Specifications for Filing Forms W-2 Electronically (EFW2) 

Record Changes 

 Section 4.6 RE Record – Employer Record: The following fields have been added:  

 Employer Contact Name (positions 222–248) 
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 Employer Contact Phone Number (positions 249–263) 

 Employer Contact Phone Extension (positions 264–268) 

 Employer Contact Fax Number (positions 269–278) 

 Employer Contact E-Mail/Internet (positions 279–318) 

Other Changes 

Section 4.5 RA Record – Submitter Record: New specifications have been added to 
the Contact E-Mail/Internet (positions 446–485) field. 

Section 4.6 RE Record – Employer Record: The Other EIN (positions 31–39) is now 
applicable to all tax jurisdiction codes.  

Section 7.3 Data Requirements: Data requirements for submitting files have changed. 
Social Security prefers delimited files.  

State Updates 

State Electronic Filing 

These are the changes due to EFW2 updates: 

 The following fields are added to the RE Record: 

 Employer Contact Name (RE Record POS 222–248) 

 Employer Contact Phone Number (RE Record POS 249–263) 

 Employer Contact Phone Extension (RE Record POS 264–268) 

 Employer Contact Fax Number (RE Record POS 269–278) 

 Employer Contact E-Mail/Internet (RE Record POS 279–318) 

New specifications have been added to the Contact E-Mail/Internet (RA Record POS 
446–485) field. 

 The Other EIN (RE Record POS 31–39) is now applicable to all tax jurisdiction codes. 

Data requirements for submitting files have changed. Social Security prefers delimited 
files.  

The following is a list of states using standard EFW2 for RA and RE records: 

 Arkansas 

 Arizona 

 Colorado 

 Connecticut 

 District of Columbia 

 Delaware 

 Georgia 

 Idaho 

 Illinois 

 Indiana 

 Kansas 
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 Kentucky 

 Louisiana 

 Maryland (RA only) 

 Maine 

 Michigan 

 Minnesota 

 Missouri 

 Mississippi 

 Montana 

 North Carolina 

 North Dakota 

 Nebraska 

 New Jersey 

 New Mexico 

 Ohio 

 Oregon 

 Pennsylvania (RA only) 

 Puerto Rico 

 Rhode Island 

 South Carolina 

 Utah 

 Virginia 

 Vermont 

 Wisconsin 

 West Virginia 

California 

California has released income tax withholding tables for Method B, the Exact Calculation 
Method, and instructions for Method B, effective for 2014. The annual standard deduction 
increases from $3,841 to $3,906. 

Connecticut 

The following are the updates for Connecticut: 

 Updated the Personal Exemption table for filing status F 

 Updated the Personal Tax Credit table for filing status F 

Delaware 

The income tax rate for earnings of more than $60,000 decreases from 6.75% to 6.6%. The rate 
replaces the previously announced rate, which had been scheduled to fall to 5.95%. 

Idaho 
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Existing split-monthly filers will change to a semimonthly filing frequency, paying income tax 
withholding twice a month. Existing split-monthly filers (filing cycle = B) are no longer required to 
include payments made from January 1, 2014 to January 15, 2014 with the RV Record. Instead, 
payments made from January 1, 2013 to January 15, 2013 will be reported in RV Record 
Positions 65–75 (the amount for this period was included in your 2012 submission). 

We updated Vision RS Record Positions 248–267 and RV Record Positions 16–24 and 54–97 to 
accommodate this change.  

Kansas 

Kansas has updated its withholding rates from 3% to 2.7% (for wages over $3,000 but not over 
$18,000) and from 4.9% to 4.8% (for wages over $18,000). 

Kentucky 

 The standard deduction increases from $2,360 to $2,400. 

 The tax credit decreases from $20 to $10. 

Maine 

The following are updated: 

 Withholding Table 

 Withholding Allowance Amount 

 Nonresident Alien Adjustment Amount 

Maryland 

The Central Registration Number required in RE Record POS 222–229 has been rescinded. 
The Social Security Administration has added five new fields in the RE Record, resulting in the 
overlapping of information. 

Local income tax withholding rates change for these counties: 

 Caroline — rate increases from 2.63% to 2.73% 

 Carroll — rate decreases from 3.05% to 3.04% 

 Charles — rate increases from 2.90% to 3.03% 

Massachusetts 

Massachusetts has updated its state electronic filing. The following fields are added to Section 
4.6 RE Record – Employer Record: 

 Tax Jurisdiction Code (position 220) 

 Third Party Sick Pay Indicator (position 221) 

 Employer Contact Name (positions 222–248) 

 Employer Contact Phone Number (positions 249–263) 

 Employer Contact Phone Extension (positions 264–268) 

 Employer Contact Fax Number (positions 269–278) 

 Employer Contact E-Mail/Internet (positions 279–318) 

Minnesota 

The withholding allowance increases from $3,900 to $3,950. 

New Jersey 
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Test/Production Indicator is now reported in RS Record POS 5–9, with a default value of “P.” 

New Mexico 

 One allowance amount increases from $3,900 to $3,950. 

 Tables for percentage method of withholding are updated for Single and Married filing 
statuses. 

New York 

 The Single Deduction Allowance Amount increases from $7,150 to $7,250. 

 The Married Deduction Allowance Amount increases from $7,650 to $7,750. 

 The Single annual tax rate schedule table changes. 

 The Married annual tax rate schedule table changes. 

Adjustment for difference between federal and New York exemption allowances 
increases from $2,800 to $2,900. 

 The Supplemental Tax Rate (bonus) is 9.62%. 

North Carolina 

North Carolina has updated its income tax rates to a flat 5.8%. This flat rate replaces a three-
bracket structure that had rates of 6%, 7%, and 7.75%. 

Rhode Island 

 The annual tax table has changed for all filing statuses. 

 The threshold for the 0.00 allowance amount increases from $202,950 to $211,300. 

1099-MISC Form 

The 1099-MISC Form is updated to realign the following fields: 

 Recipient's Name 

 Street Address 

 City, State, and Zip 

Two new fields are also added: 

 Box 11 — Foreign Tax Paid 

 Box 12 — Foreign country or US possession 

1099 Electronic Filing 

The Type of TIN field (position 11 of the Payee B Record) is now required.  

To accommodate this change, Vision added the Type of TIN field on the Accounting tab of 
Vendor Info Center, and included this field in the 1099 Electronic File. 

Files Updated 

aprptForm1099.rdl 
aprptForm1099Custom.rdl 
Deltek.Vision.APForm1099.Client.dll 
Deltek.Vision.APForm1099.Server.dll 
Deltek.Vision.PayrollBO.Server.dll 
Deltek.Vision.VendorInfoCenter.Client.dll 
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Deltek.Vision.W2Form.Client.dll 
Deltek.Vision.W2Form.Server.dll 

Vision 

Defect Tracking Number: 399958 

Description: This issue applies if you use the SEPA file format for making payments. The 
amounts in the .xml file did not have the required two decimals. The BtchBookg tag was missing.  

Impact: This defect applies to Vision 6.2 SP2 and later versions. 

Workaround: Manually edit the .xml files. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.APPaymentProcess.Server.dll 
Deltek.Vision.EmpPaymentBO.Server.dll 

Other Applications Affected  

System File Dependencies  

Accounting/Project Review 

Defect Tracking Number: 401890 

Description: Credit memos that use a custom template did not preview correctly in Project 
Review. 

Impact: This defect affects Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ARReviewDialogs.Client.dll 

Other Applications Affected  

System File Dependencies  

Void Check 

Defect Tracking Number: 402489 

Description: If you use the French language for Vision, you received an error when you printed a 
posting log for voided checks in Accounting » Void Check.  

Impact: This applies if you use the French language in Vision 7.1.  

Workaround: Preview and print the log in Transaction Center » Posting Logs.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.VoidCheck.Client.dll 
Deltek.Vision.VoidCheck.Server.dll 

Other Applications Affected  

System File Dependencies  
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API 

Defect Tracking Number: 398733 

Description: This applies if you use VisionXtend APIs. The Web Services APIs did not correctly 
populate the values in lookup and dropdown fields in User-Defined Info Centers in Vision.  

Impact: This issue applies to VisionXtend 7.1.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 398816 

Description: This applies if you use VisionXtend. The Web Service API did not work when the 
data XML file included only the Vision xxCustomTabFields table.  

Impact: This issue applies to VisionXtend 7.1.  

Workaround: You must include the main Vision table in the data XMLfile.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 403027 

Description: 

This applies if you use VisionXtend APIs. If you modified the address for a Client Info Center 
record using the Web Services API, you received the error message: "Cannot update Address 
description in for the Client IC records." 

The following is now the correct way to update the Client Address fields using Web Services 
APIs: 

1. Assign the original value entered in the Address field to the "origVal" attribute. 

2. Assign the new value for the Address field to the "new_val" attribute. 

Important: You must assign the original value of the Address field to the element. 

Example: 

<RECS xmlns="http://deltek.vision.com/XMLSchema" 
xmlns:xdv="http://deltek.vision.com/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"> 

<REC> 

<CL name="CL" alias="CL" keys="ClientID"> 

<ROW tranType="UPDATE"> 
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<ClientID>ADVCLIENTA000000CVS</ClientID> 

<Client>0000000CVS</Client> 

<Name>API Updated Consumer Value Stores-CVS</Name> 

</ROW> 

</CL> 

<CLAddress name="CLAddress" alias="CLAddress" keys="ClientID,Address"> 

<ROW tranType="UPDATE"> 

<ClientID>ADVCLIENTA000000CVS</ClientID> 

<Address origVal="MainContact" new_val="NewMainContact">MainContact</Address> 

<Address1>API Updated Address1</Address1> 

<Address2>API Updated Address2</Address2> 

</ROW> 

</CLAddress> 

</REC> 

</RECS> 

Impact: This issue applies to Vision 7.0 and later releases. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Info Center/Projects 

Defect Tracking Number: 402391 

Description: The Opportunity field in a new project record did not automatically populate with the 
opportunity's information under the following circumstances:  

1. A new opportunity record was created. 

2. The opportunity was linked to a promotional project. 

3. A new project record was created from the promotional project.  

Impact: This issue applies to Vision 7.1 and later versions.  

Workaround: You must manually enter the Opportunity field's information when a new project 
record is created from a promotional project.  

Additional Notes: A warning message now displays to alert the user of this issue. 

Files Updated  
Deltek.Vision.ProjectInfoCenter.Server.DLL 

Other Applications Affected  

System File Dependencies  
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Database Changes  

The following .SQL script (DeltekVision71GAHotFix012.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 013 (January 10, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #012 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #013, please review their descriptions above in 
this document. 

Important Note: IF YOU USE VISION PAYROLL, DO NOT INSTALL THIS HOT FIX IF YOU 
HAVE NOT PROCESSED THE FINAL PAYROLL FOR 2013. This Hot Fix includes the 2014 tax 
updates. A second update will be released in early 2014 which will contain any additional state 
and federal changes. 

Billing/Invoice Approvals 

Defect Tracking Number: 398468 

Description: When you clicked Billing » Invoice Approvals, the Invoice Approvals screen took a 
long time to load. 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Database Changes: Updated the CreateApproverTable stored procedure. 

Files Updated  
sp_CreateApproverTable.sql 
Deltek.Vision.Billing.Server.dll 
Deltek.Vision.interactiveBilling.Client.dll 
Deltek.Vision.ReportingBilling.Server.dll 

Other Applications Affected  
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System File Dependencies  

Info Center/Projects 

Defect Tracking Number: 404320 

Description: You received an error when you copied a project from an existing project and you 
did not specify the new project's charge type in the New Project Type field on the Create Project 
from... dialog box. 

Impact: This defect applies for Vision 7.0 SP1 and later versions. 

Workaround: Select a charge type in the New Project Type field.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.ProjectInfoCenter.Server.DLL 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GACUHotFix013.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 014 (January 24, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #013 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #014, please review their descriptions above in 
this document. 

2014 Q1 Regulatory Updates 

All changes are effective as of January 1, 2014, unless otherwise noted.  

The updates in this section include: 
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 State Updates  
 Form 941 Update 
 Files Updated 

State Updates 

Illinois 

Personal exemption amount increases from $2,100 to $2,125. The withholding rate 
remains at 5%. 

Massachusetts 

 Withholding rate decreases from 5.25% to 5.20%. 
 Head of household tax value amount decreases from $126.00 to $124.80. 
 Blind tax value amount decreases from $115.50 to $114.40. 
 Supplemental tax rate decreases from 5.25% to 5.20%. 

Michigan 

Personal exemption amount is $4,000. The withholding rate and method remain the 
same. 

Mississippi 

Mississippi has provided RS custom record specification. Previously, Mississippi has 
instructed to follow the EFW2 format. 

Missouri 

 Single Standard Deduction increases from $6,100 to $6,200. 
 Married and Spouse Works Standard Deduction increases from $6,100 to $6,200. 
 Married and Spouse Does Not Work Standard Deduction increases from $12,200 to 
$12,400. 
 Head of Household Standard Deduction increases from $8,950 to $9,100. 

North Dakota 

 Single and Married tax tables are updated. 
 The amount of one withholding allowance increases from $3,900 to $3,950. 

Oklahoma 

Single and Married tax tables are updated. 

Oregon 

The federal tax adjustment amount increases from $6,250 to $6,350 for an employee with 
annual wages of up to $50,000. 

The federal tax adjustment phase out amounts for an employee with annual wages 
$50,000 or greater change. 
 
The tax table for the following employees has changed: 

Employee with annual wages of up to $50,000 
Employee with annual wages of $50,000 or higher 
The allowance amount increases from $188 to $191. 

The standard deduction amount increases for the following employees: 

 Single filing status with less than 3 allowances — from $2,080 to $2,115 
 Single filing status with more than 3 allowances — from $4,160 to $4,230 
 Married filing status — from $4,160 to $4,230 
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Personal exemptions are eliminated for those who earn at least $100,000 and file as 
single or married separately, and for those who file married jointly or head of household 
and earn at least $200,000. 

Puerto Rico 

 Allowance amount for the special deduction table is updated. 
 Withholding table is updated. 

Vermont 

 Single and Married tax tables are updated. 
 The amount of one withholding allowance increases from $3,900 to $3,950. 
 Supplemental tax is at 24% of the federal withholding. 

Form 941 Update 

Form 941 for 2013 has been updated. 

Files Updated 

Deltek.Vision.PayrollBO.Server.dll 
Deltek.Vision.ReportingPayroll.Server.dll 
Deltek.Vision.W2Form.Server.dll 
Form941.rdl 

Accounting/Adjust Salaried Job Cost 

Defect Tracking Number: 402195 

Description: This applies if you have multiple companies in Vision. On the Adjust Salaried Job 
Cost form, when you clicked Process, if the items processed included timesheet charges to 
projects from a company other than the active company, you received an error.  

Impact: This issue applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.AdjustSalariedJobCost.Server.dll 

Other Applications Affected  

System File Dependencies  

Billing/Batch Billing 

Defect Tracking Number: 398183 

Description: In Batch Billing, you did not have the option to sort invoices based on the biller 
specified in Project Info Center. This cumulative update adds the options to sort invoices based 
on the biller's employee number or name. 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.BatchBilling.Client.dll 
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Deltek.Vision.Billing.Server.dll 
Invoice Summary.rdl 

Other Applications Affected  

System File Dependencies  

Info Center/Projects 

Defect Tracking Number: 402885 

Description: When you added or saved data in the Touch Time application, you received the 
following message: “There was no response from the server. Need to refresh application.”  

Impact: This defect applies to 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: You also received this message when you used the web browser, but not as 
frequently as when you used the Touch Time native application.  

Files Updated  
Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Project 

Defect Tracking Number: 400456 

Description: Some expense descriptions on the Project Progress report were truncated. 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected  

System File Dependencies  

Updated URL for GovWin IQ Integration  

The URLs that Vision uses to communicate with GovWin IQ have been updated to use the 
current GovWin IQ domain name, rather than the old Input domain name. 

Files Updated 
Deltek.Vision.InputWebService.Server.dll 

Key Performance Indicators (KPIs) Added to Vision Analysis Cubes 

The following new KPIs have been added to the Key Performance Indicators tab in 
Configuration » General » Analysis Cubes. 

KPI Description  KPI Label  

Billed by Plan Org2  RevenueTargetOrg2 
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KPI Description  KPI Label  

Billed by Plan Org3  RevenueTargetOrg3 

Billed by Plan Org4  RevenueTargetOrg4 

Billed by Plan Org5  RevenueTargetOrg5 

Contract Total Compensation by Project Org2  ContractSalesTargetOrg2 

Contract Total Compensation by Project Org3  ContractSalesTargetOrg3 

Contract Total Compensation by Project Org4  ContractSalesTargetOrg4 

Contract Total Compensation by Project Org5  ContractSalesTargetOrg5 

Days Sales Outstanding over 90 by Project Org2  DSOTargetOrg2 

Days Sales Outstanding over 90 by Project Org3  DSOTargetOrg3 

Days Sales Outstanding over 90 by Project Org4  DSOTargetOrg4 

Days Sales Outstanding over 90 by Project Org5  DSOTargetOrg5 

Days Work In Process Outstanding over 90 by 
Project Org2  

DWOTargetOrg2 

Days Work In Process Outstanding over 90 by 
Project Org3  

DWOTargetOrg3 

Days Work In Process Outstanding over 90 by 
Project Org4  

DWOTargetOrg4 

Days Work In Process Outstanding over 90 by 
Project Org5  

DWOTargetOrg5 

Effective Multiplier by Project Org2 EffectiveMultiplierTargetOrg2 

Effective Multiplier by Project Org3 EffectiveMultiplierTargetOrg3 

Effective Multiplier by Project Org4 EffectiveMultiplierTargetOrg4 

Effective Multiplier by Project Org5 EffectiveMultiplierTargetOrg5 

Gross Margin Percent by Project Org2  ProfitPercentexlcudingOHTargetOrg2 

Gross Margin Percent by Project Org3 ProfitPercentexlcudingOHTargetOrg3 

Gross Margin Percent by Project Org4  ProfitPercentexlcudingOHTargetOrg4 

Gross Margin Percent by Project Org5  ProfitPercentexlcudingOHTargetOrg5  
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KPI Description  KPI Label  

Opportunity Revenue by Opportunity Org2  OpportunitySalesTargetOrg2  

Opportunity Revenue by Opportunity Org3  OpportunitySalesTargetOrg3 

Opportunity Revenue by Opportunity Org4  OpportunitySalesTargetOrg4 

Opportunity Revenue by Opportunity Org5  OpportunitySalesTargetOrg5 

Realization Ratio by Project Org2  RealizationRatioTargetOrg2 

Realization Ratio by Project Org3  RealizationRatioTargetOrg3 

Realization Ratio by Project Org4  RealizationRatioTargetOrg4 

Realization Ratio by Project Org5  RealizationRatioTargetOrg5 

Revenue by Project Org2 RevenueTargetProjectOrg2 

Revenue by Project Org3  RevenueTargetProjectOrg3 

Revenue by Project Org4  RevenueTargetProjectOrg4 

Revenue by Project Org5  RevenueTargetProjectOrg5 

Variance Percent by Project Org2  VariancePercentTargetOrg2  

Variance Percent by Project Org3  VariancePercentTargetOrg3 

Variance Percent by Project Org4  VariancePercentTargetOrg4 

Variance Percent by Project Org5  VariancePercentTargetOrg5 

You can use these KPIs in custom reports or dashboards. In Performance Management 
dashboards that use KPIs, these KPIs support filtering by organization level. When you select 
organization levels in the Vision Resource Kit and publish workbooks that are filterable by 
organization to the Tableau server, those organization levels determine what Key Performance 
Indicators (KPIs) are used. For example, if you select org levels 1 and 2 in the Resource Kit, the 
KPIs labeled “…Org1” and “…Org2” are used for those workbooks. 

Files Updated 

Create_Deltek_Vision_Cubes.xmla 
DeltekVisionHelper.dll 
DeltekVisionResourceKit.exe 
Deltek.Vision.AnalysisCubes.Client.dll 
sp_AddDefaultKPI.sql  
Business Development Manager Sample - Opportunity Wins and Projections.twb 
Business Development Manager Sample - Pipeline Revenue.twb 
Business Development Manager Sample - Promotional Costs.twb 
Executive Sample - Accounts Receivable and Promotional Costs - EE.twb 
Executive Sample - Days Outstanding Metrics - EE.twb 
Executive Sample - Opportunity Wins and Projections.twb 
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Executive Sample - Pipeline Revenue.twb 
Executive Sample - Profit Drilldown.twb 
Executive Sample - Project Status.twb 
Executive Sample - Promotional Costs - SE.twb 
Executive Sample - Revenue Analysis.twb 
Executive Sample - Trends and Multipliers.twb 
Executive Sample - Utilization and Realization.twb 
Finance Sample - Balance Sheet Charts.twb 
Finance Sample - Income Charts.twb 
Organization Manager Sample - Accounts Receivable Trending - EE.twb 
Organization Manager Sample - Charts at Billing.twb 
Organization Manager Sample - Charts at Cost.twb 
Organization Manager Sample - Days Outstanding Metrics - EE.twb 
Organization Manager Sample - Opportunity Wins and Projections.twb 
Organization Manager Sample - Pipeline Revenue.twb 
Organization Manager Sample - Profit Drilldown.twb 
Organization Manager Sample - Project Status.twb 
Organization Manager Sample - Variance Drilldown.twb 
Principal Sample - Accounts Receivable Trending - EE.twb 
Principal Sample - Charts at Billing.twb 
Principal Sample - Charts at Cost.twb 
Principal Sample - Days Outstanding Metrics - EE.twb 
Principal Sample - Opportunity Wins and Projections.twb 
Principal Sample - Pipeline Revenue.twb 
Principal Sample - Profit Drilldown.twb 
Principal Sample - Project Status.twb 
Principal Sample - Variance Drilldown.twb 
Project Manager Sample - Charts at Billing.twb 
Project Manager Sample - Charts at Cost.twb 
Project Manager Sample - Days Outstanding Metrics - EE.twb 
Project Manager Sample - Profit Drilldown.twb 
Project Manager Sample - Project AR.twb 
Project Manager Sample - Project Status.twb 
Project Manager Sample - Variance Drilldown.twb 
Resource Manager Sample - Opportunity Wins and Projections.twb 
Resource Manager Sample - Pipeline Revenue.twb 
Resource Manager Sample - Utilization and Realization.twb 

Database Changes 

Updated Objects 

 The following object was updated: AddDefaultKPI (stored procedure). 

Database Changes  

The following .SQL script (DeltekVision71GACUHotFix014.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
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or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 015 (February 7, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #014 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #015, please review their descriptions above in 
this document. 

Analysis Cubes 

Defect Tracking Number: 397548 

Description: The Unit Total Cost and Net Revenue measures in Vision Analysis Cubes 
incorrectly included indirect and other charge expenses.  

Impact: This defect applies if you use Vision 7.1 and later versions of Performance Management 
(Analysis Cubes).  

Workaround: None. 

Additional Notes: None. 

Files Updated  
v_ExpenseBilling.sql  
v_Expenses.sql  
Create_Deltek_Vision_Cubes.xmla  

Other Applications Affected  

System File Dependencies  

Billing 

Defect Tracking Number: 401234 

Description: When multiple users were using Interactive Approvals at the same time, they 
intermittently received one of these errors: "DocumentElement already exists" or "object 
reference." 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Framework.Globals.Common.dll 

Other Applications Affected  
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System File Dependencies  

Configuration/Accounting/Banks 

Defect Tracking Number: 407452 

Description: This applies if you use the SEPA export-to-text format (selected in Banks 
Configuration) when you make payments in Vision. The amounts in the SEPA file were defined 
with a comma (,) and they should have been defined with a period (.). The file also incorrectly 
included the Group header "<BtchBookg>true</BtchBookg>" element, which has been removed.  

Impact: This applies to Vision 6.2 SP2 and later versions. 

Workaround: Manually adjust the SEPA file. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.APPaymentProcess.Server.dll 
Deltek.Vision.EmpPaymentBO.Server.dll 

Other Applications Affected  

System File Dependencies  

Info Center/Projects 

Defect Tracking Number: 400113 

Description: When a phase or task did not have the Approved for use in Processing option 
selected on the General tab of the Project Info Center, the same phase or task was not included 
in the WBS lookup on the Contract Details grid. This grid is located on the Contract Management 
tab of the Project Info Center.  

Impact: This issue applies to Vision 7.1 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.ProjectInfoCenter.Client.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 400653 

Description: When a new record was created in the Project Info Center using the New » Create 
Project from Opportunity or  New » Create Project from Template menu options, the default 
values for user-defined fields were not populating. This applied to user-defined fields that were 
created for versions prior to Vision 7.x. 

Impact: This issue applies to Vision 7.1 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.ProjectInfoCenter.Server.dll 

Other Applications Affected  

System File Dependencies  
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Defect Tracking Number: 407484 

Description: When an autonumber stored procedure was used to create a new promotional or 
regular project record in the Project Info Center (New » Create Project from Opportunity), Vision 
displayed an error message. 

Impact: This issue applies to Vision 7.0 SP1 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.ProjectInfoCenter.Server.dll 

Other Applications Affected  

System File Dependencies  

Performance Dashboards 

Connect Custom Performance Dashboards to Vision Database 

While all of the sample performance dashboards and most custom dashboards that that you 
create use the Analysis Cubes as the data source, you now also have the option to connect your 
custom dashboards directly to your Vision transactional database. 

Files Updated 
Deltek.Framework.PerformanceDashboard.Server.dll 
Deltek.Vision.PerformanceDashboard.Server.dll 
DeltekVisionResourceKit.exe 

Database Changes  

The following .SQL script (DeltekVision71GACUHotFix014.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 
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Cumulative Hot Fix 016 (February 21, 2014) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #015 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #016, please review their descriptions above in 
this document. 

Accounting/Accounts Receivable/Invoice Review 

Defect Tracking Number: 405677 

Description: The Average age of receivable number that displays on the Invoice Review form 
incorrectly included voided invoices in its calculation. 

Impact: This applies to Vision 7.0 SP1 and later versions. 

Workaround: Use the AR Ledger report in Reporting » Accounts Receivable. Select the Print 
Average Collection Period check box on the Options tab of the AR Ledger Options dialog box. 
The Average Collection Period (number of days) that prints on the report is the same as the 
Average age of receivables in Invoice Review.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.ARReview.Client.dll 

Other Applications Affected  

System File Dependencies  

Project Review 

Defect Tracking Number: 405674 

Description: The Average age of receivable number that displays on the Accounts Receivable 
tab in Project Review incorrectly included voided invoices in its calculation. 

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: Use the AR Ledger report in Reporting » Accounts Receivable. Select the Print 
Average Collection Period check box on the Options tab of the AR Ledger Options dialog box. 
The Average Collection Period (number of days) that prints on the report is the same as the 
Average age of receivables in Project Review.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.ProjectPTDReview.Client.dll 

Other Applications Affected  

System File Dependencies  

Billing/Billing Terms 

Defect Tracking Number: 406694 

Description: On the Add-Ons tab of the Billing Terms form, you could enter four decimal digits 
when you entered percentages, but Vision then rounded them to 2 decimal digits. After you install 
this fix, all four decimal digits will be retained. 
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Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.BillingTerms.Client.dll 

Other Applications Affected  

System File Dependencies  

Interactive Billing 

Defect Tracking Number: 406947 

Description: If you transferred an employee expense with a business reason in Interactive 
Billing, the business reason was not included on the Billing Backup report even though the target 
project's billing terms were set up to print billing reasons on that report. 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
BackupConsultant.rdl 
BackupExpense.rdl  

Other Applications Affected  

System File Dependencies  

Mobile Time 

Defect Tracking Number: 409527 

Description: When there was a large number of records in the database and the user's role's 
access was set to Read Only on the Record Access tab of Configuration » Security » Roles, 
running a query on Projects in the Touch Time application did not return any results.  

Impact: This issue applies to clients using Vision 7.1 and later versions.  

Workaround: Remove the Read Only setting in Configuration » Security » Roles.  

Additional Notes: None. 

Other Applications Affected  

System File Dependencies  

Planning 

Defect Tracking Number: 407935 

Description: The project lookup in a project field could take more than a minute to return results 
if you had a large number of projects (111,000+) and you did not filter the lookup search to limit 
the results list. This applied to the following project fields in Planning and the Project Info Center: 

� The Select Specific Project field on the Create Plan from Project dialog box in Project 
Planning. (On the Project Planning form click New » New Plan from Existing Project to 
open this dialog box.) 

� The Project column in the Labor grid on the Labor tab on the Project Planning form. 
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� The Merge with Project field on the Create Project from Plan dialog box in the Project Info 
Center. (On the Project Info Center form, click New » Create Project from Plan to open 
this dialog box.) 

Impact: This applies to Vision 7.0 SP1 and later releases. 

Workaround: Apply a filter for the project lookup to limit the number of projects that are returned 
in the search. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.DlgCreateProjectFromPlan.Client.dll 
Deltek.Vision.ResourcePlanning.Client.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Payroll 

Defect Tracking Number: 406664 

Description: The amounts in the Schedule B section of the Form 941 Worksheet did not match 
the corresponding amounts on the Payroll Journal and the payroll posting logs. 

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingPayroll.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GACUHotFix014.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 
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Cumulative Hot Fix 017 (March 7, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #016 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #017, please review their descriptions above in 
this document. 

Billing 

Defect Tracking Number: 404374 

Description: If you selected Disable Upset Limits in the Billing Session Options dialog box and 
you accepted an invoice in Interactive Billing that had gone through the invoice approvals process 
and been approved, the Disable Upset Limits option was ignored, and the upset limits were 
applied to the invoice. 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: The Disable Upset Limits option functioned correctly for invoices for which 
invoice approval was not enabled. 

Files Updated  
Deltek.Vision.interactiveBilling.Client.dll 
Deltek.Vision.Billing.Server.dll 

Other Applications Affected  

System File Dependencies  

Mobile Time 

Defect Tracking Number: 412911 

Description: When using Touch Time with a large database and a role that was set to Is Mine for 
Projects (Configuration » Security » Roles » Record Access), tapping + in Find Project returned 
no records for a Timesheet Period. 

Impact: This issue applies to clients using Vision Touch Time. 

Workaround: Remove the Is Mine filter or change it to Equals in Configuration » Security » Roles 
» Record Access.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected  

System File Dependencies  

Proposals/SF330 Proposals 

Defect Tracking Number: 408873 

Description: When firms in Firm Setup – Proposals selected one organization as the Parent Firm 
on the Additional Info tab,  yet this firm was marked as the Parent on the General tab under Firm 
Setup – Proposals, the SF330 Part II Block 9 c(2) displayed the branch count as zero.  
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Impact: This issue applies to Vision 7.0 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.sf330.Client.DLL 

Other Applications Affected  

System File Dependencies  

Transaction Center/Transaction Entry and Transaction Posting 

Defect Tracking Number: 413247 

Description: There was an issue where the tax debit amount in voucher posting did not match 
the tax amount in the functional currency that was stored for the voucher line item. This caused a 
discrepancy where the General Ledger and File Rec Accounts Payable balance did not match the 
Voucher Ledger. 

Impact: This issue applies to clients using Vision 6.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.Posting.Server.dll 

Other Applications Affected  

System File Dependencies  

Utilities/Process Server 

Defect Tracking Number: 405146 

Description: Making a change in Weblink resulted in a restart of the process server, which could 
end jobs that were running at the time of the restart. 

Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Framework.Ancestors.Server.dll 
Deltek.Framework.ProcessServer.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GACUHotFix014.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 
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Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 018 (March 21, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #017 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #018, please review their descriptions above in 
this document. 

Regulatory Updates/State Updates 

Pennsylvania 

Pennsylvania has made the following record updates for SUTA Magnetic Media. 

Rec/Pos/Field Old Description New Description 

S, 11-30, Employee Last 
Name 

Enter employee last name. If 
the name has a suffix 
(JR/SR/II etc.), enter a blank 
after the last name then the 
suffix. 

Enter employee last name. If the 
name has a suffix (JR SR II etc.), 
enter a dash (no space) after the 
last name then the suffix. 

T, 27-40, State QTR 
Unemployment 
Compensation Total 
Wages for Employer 

Enter quarterly gross wages 
subject to state UC tax. 
Include all tip income. (The 
total of this field on all S 
records since the last E 
record.) 

Enter quarterly gross wages 
subject to state UC tax. Include all 
tip income. The total of this field on 
all S records since the last E 
record for original file. See 
instructions in Amended Wage and 
Tax File in S4. 

T, 55-68, State QTR 
Unemployment 
Compensation Taxable 
Wages for Employer 

Enter quarterly taxable 
wages subject to 
Unemployment taxes. 

Enter quarterly taxable wages 
subject to Unemployment taxes. 
Reimbursable financial method 
employers should enter zeros. See 
instructions in Amended Wage and 
Tax File in S4. 

T, 149-159, Employer 
Contribution Amount 

Enter employer contributions 
due (taxable wages 

Enter employer contributions due 
(taxable wages multiplied by 
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Rec/Pos/Field Old Description New Description 

multiplied by employer PA 
contribution rate). 

employer PA contribution rate). 
See instructions in Amended Wage 
and Tax File in S4. 

T, 164-174, Employee 
Withholding Amount 

Enter employee withholding 
due (gross wages multiplied 
by the employee withholding 
rate). 

Enter employee withholding due 
(gross wages multiplied by the 
employee withholding rate). See 
instructions in Amended Wage and 
Tax File in S4. 

Files Updated 

Deltek.Vision.pyFormQuarterly.Client.dll 
Deltek.Vision.QTRMagMedia.Server.dll 

Wisconsin 

The following Wisconsin tax table changes have been made to provide alternate methods A and 
B (effective April 1, 2014): 

� The Single and Married percentage method withholding tables were updated. 

� The supplemental withholding percentage table was updated. 

Files Updated 
Deltek.Vision.PayrollBO.Server.dll 

Configuration/Security » Roles 

Role Summary Report 

The Navigator section of the Role Summary report now contains Expense Report tab information. 
You access this report by clicking Print on the Roles form in Configuration » Security » Roles. 

Files updated: 

RoleNavigatorSection.rdl  
Deltek.Vision.ReportLabels.Server.dll 
Deltek.Vision.ReportingConfiguration.Client.dll 

Vision 

Defect Tracking Number: 411689 

Description: When a document was uploaded but not attached to an expense report, Vision did 
not validate the attachment until attempting to save. At that point, you could choose to attach the 
document to an expense report, or delete the document. Vision was updated so this validation 
now occurs when the expense report is submitted.  

Impact: This issue applies to clients using Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.Expensekeeper.Server.dll 
Deltek.Vision.Expensekeeper.Client.dll 
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Other Applications Affected  

System File Dependencies 

Time and Expense/Expense Report 

Defect Tracking Number: 413777 

Description: When a supporting document was attached to an approved expense line item on an 
Expense Report, Vision displayed a Warning message but continued to allow the delete. This has 
been changed and an error message displays to stop the delete. 

Impact: This issue applies to clients using Vision 7.1 and later versions.  

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.Expensekeeper.Client.dll 
Deltek.Vision.dlgSupportingDocument.Client.dll 

Other Applications Affected  

System File Dependencies  

Database Changes 

New Columns Added: 

� NavExpRpt to the SE table 

Objects Updated: 

� fn_PN$tabARAging.SQL 

� fn_PN$tabTask.SQL 

� fn_PN$tabResPlanned.sql 

� fn_PN$tabLabRes.SQL 

� fn_PN$tabLabPlanned.sql 

� fn_PN$tabLabEAC.sql 

� fn_PN$tabLabBaseline.sql 

Database Changes  

The following .SQL script (DeltekVision71GACUHotFix018.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 
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Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 019 (April 4, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #018 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #019, please review their descriptions above in 
this document. 

Accounting/Revenue/Revenue Generation 

Defect Tracking Number: 415822 

Description: If you ran Revenue Generation with selection criteria of Company or Organization at 
the work breakdown structure 3 (task) level, duplicate gain or loss entries were made in error.  

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.RevenueGeneration.Server.dll 

Other Applications Affected  

System File Dependencies  

Billing/Interactive Billing 

Defect Tracking Number: 412979 

Description: When previewing an invoice for a project from the Invoices on File dialog box, if you 
declined to preview supporting documents also and you then previewed an invoice for a another 
project, the invoice displayed for the second project was the invoice for the first project. 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: You can include the supporting documents when you preview the invoices, or you 
can disable the Print Supporting Documents option for the project on the Billing Backup tab of 
Billing Terms before previewing the invoice and then select that option again when you are 
through previewing. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.interactiveBilling.Client.dll 

Other Applications Affected  

System File Dependencies  
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Microsoft Office Desktop Integration 

Defect Tracking Number: 410195 

Description: MODI and Outlook Add-In would not load in Outlook 2013. 

Impact: This defect applies to Vision 7.1 and later versions. 

Workaround: None. 

Additional Notes: After you install this Cumulative Update, you must rerun 
DeltekMicrosoftOfficeAndDesktopIntegration.msi in the Web\Integration folder. 

Files Updated  
DeltekMicrosoftOfficeAndDesktopIntegration.msi 

Other Applications Affected  

System File Dependencies  

Navigator 

Defect Tracking Number: 416082 

Description: When a project was selected on the Kona panel within the Navigator application, an 
error message displayed. This only occurred when the Navigator session was launched from the 
Vision application.  

Impact: This issue applies to clients using Vision 7.1 and later versions.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
Deltek.Framework.Controls.Client.dll 

Other Applications Affected  

System File Dependencies  

Defect Tracking Number: 418441 

Description: When entering an expense item’s details in the Navigator Expense Report 
application, Navigator did not honor the security access rights that were assigned to Staff users 
for the selected category. This resulted in the Account field being enabled and incorrectly 
available for edits. 

Impact: This applies to Vision 7.1. 

Workaround: Require a category and do not show the Account Number or Name columns on the 
grid (Configuration > Time & Expense > Company Expense Report Configuration). 

Additional Notes: None. 

Files Updated  
deltek.vision.visionservices.server.dll 

Other Applications Affected   

System File Dependencies  
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Database Changes  

The following .SQL script (DeltekVision71GACUHotFix018.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 020 (April 18, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #019 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #020, please review their descriptions above in 
this document. 

Billing/Interactive Billing 

Defect Tracking Number: 407922 

Description: If employee realization is enabled and you wrote off a portion of a billable employee 
unit in Interactive Billing, the corresponding realization amount was not also written off. As a 
result, when you final billed the unit and generated employee realization, the realization amount 
was incorrect. 

Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.interactiveBilling.Client.dll 

Other Applications Affected  

System File Dependencies  

Configuration 

Defect Tracking Number: 417927 



Hot Fix Descriptions as of October 17, 2014 

 

Hot Fix List 70 

 

Description: Vision would sometimes calculate the time incorrectly for scheduled workflows and 
for the start and end times for activities that were included on custom proposals. The time was off 
by one hour.  

Impact: This defect applies for Vision 7.1. 

Workaround: None. 

Additional Notes: The UTCtoLocalDate function in the Vision database was updated.  

Files Updated  
DeltekVision71GACU020.sql 

Other Applications Affected  

System File Dependencies  

Mobile Time 

Defect Tracking Number: 417285 

Description: An error was encountered when a custom field was used as part of a query in 
Touch Time. This only occurred when a non-Multicompany database was in use.  

Impact: This issue applies to clients using Vision Touch Time.  

Workaround: None. 

Additional Notes: Do not use a custom field as part of a query. 

Files Updated  
Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GACUHotFix018.sql) must be run on each database to 
which this HotFix is being applied. You can either select the database on the screen, which will 
also make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 
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Cumulative Hot Fix 021 (May 2, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #020 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #021, please review their descriptions above in 
this document. 

Accounting/Consolidations 

Defect Tracking Number: 407657 

Description: On the General tab of the Consolidated Reporting Setup form (Configuration > 
Organization > Consolidated Reporting), you were only allowed to enter balance sheet accounts 
in the Gains and Losses Account field. That restriction contradicts ASPE standards. After you 
install this update, you can enter either a balance sheet account or an income statement account. 

Impact: This defect applies to customers using both the Multicurrency and Multicompany features 
in Vision 7.0 SP1 and later versions.  

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ConsolidatedReportingSetup.Client.dll 

Other Applications Affected  

System File Dependencies  

Mobile Time 

Defect Tracking Number: 420924 

Description: In Vision Touch Time, you received a “Task is required” message when you added 
a project to a timesheet and tried to save it on the Add Project screen. This occurred if your 
Vision database has multiple work breakdown structure levels, and when you logged into Touch 
Time, you entered a username that is associated with a security role where the Project query for 
Record Access is set to “Company is mine.” 

Impact: This defect applies to Vision Touch Time clients using Vision 7.1 or 7.2.  

Workaround: Remove the Record access query.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected  

System File Dependencies  

Planning/Project Planning 

 Defect Tracking Number: 420685 

Description: When creating a project from an existing plan, any user-defined fields that were 
created prior to Vision 7.x did not auto populate with the default values. 



Hot Fix Descriptions as of October 17, 2014 

 

Hot Fix List 72 

 

Impact: This issue applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.PlanProjOpp.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GACU020.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 022 (May 16, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #021 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #022, please review their descriptions above in 
this document. 

Vision 

Defect Tracking Number: 420753 

Description: When you used the GovWin IQ Web Service utility to import opportunities from 
GovWin IQ, you sometimes received errors because the import process was not correctly 
detecting if the record already existed. 

Impact: This defect applies to customers using the GovWin IQ Web Service utility in Vision 7.0 
and later versions. 

Workaround: None. 

Additional Notes: None. 
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Files Updated  
Deltek.Vision.InputWebService.Server.dll 

Other Applications Affected  

System File Dependencies  

Accounting/Accounts Payable/Create Voucher from PO 

Defect Tracking Number: 421763 

Description: When you created a voucher from a purchase order, it took a long time to load 
vendors that had more than 100 open purchase orders.  

Impact: This applies for Vision 7.0 SP1 through 7.2. 

Workaround: None. 

Additional Notes: None. 

Database Changes: The following indexes were added to the database to improve performance: 
indexes were added to the database to improve performance: POCommitmentPODetailPKeyIDX 
and POVoucherDetailPODetailPKeyIDX. 

Files Updated  
DeltekVision71GACU022.sql 

Other Applications Affected  

System File Dependencies  

CMO 

Defect Tracking Number: 422382 

Description: When you added new activities in Connect for Microsoft Outlook and then 
synchronized, the activities were not added to Vision.  

Impact: This issue applies to Connect for Microsoft Outlook and Vision 7.1.  

Workaround: None.  

Additional Notes: None. 

Files Updated  
web\xsd\Employees_Schema.xsd 
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Costpoint CRM 

Defect Tracking Number: 420756 

Description: If an error occurred during the login to the GovWin IQ Web Service (for example, 
because the user name or password on the Configuration tab of the GovWin IQ Web Service 
utility was invalid), you did not receive a message containing information that helped you 
understand and resolve the problem. 

Impact: This defect applies to customers using the GovWin IQ Web Service utility in Vision 7.0 
and later versions. 

Workaround: None. 
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Additional Notes: None. 

Files Updated  
Deltek.Vision.InputWebService.Client.dll 
Deltek.Vision.InputWebService..Server.dll 

Other Applications Affected  

System File Dependencies  

Reporting/Accounts Receivable 

Defect Tracking Number: 256974 

Description: If you set up the AR Aged report to have page breaks between projects, the column 
headings did not display on the final page of the report. 

Impact: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  

Deltek.Vision.ReportingAccountsReceivable.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 023 (May 30, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #022 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #023, please review their descriptions above in 
this document. 
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Connect for Microsoft Outlook 

Defect Tracking Number: 428513 

Description: When an activity with an employee association to an opportunity was added in 
Outlook, or when an activity was updated in Outlook, a check issues error displayed during 
synchronization. This occurred when the following settings were established in Configuration » 
Security » Roles: 

Activity Access: Record Level Update = Full 
Activity Completion Status = Not Selected 

Impact: This issue applies to Vision Connect for Microsoft Outlook 7.1. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.WebserviceAPI.Server.dll 

Other Applications Affected  

System File Dependencies  

Info Center 

Defect Tracking Number: 426564 

Description: In rare situations, some Vision error messages did not include the correct error 
information.  

Impact: This issue applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Framework.Errors.Common.dll 

Other Applications Affected  

System File Dependencies 

Connect for Microsoft Outlook 

Adding a Task to a record in Outlook – When you try to add a task to a contact from the More » 
Assign Task menu option in the Communicate group of the ribbon, you cannot save it. You 
receive the message: “Subject, Start Date are required.” even though these fields are populated. 
Use the Create Task for Contact menu option in the Connect group of the ribbon to create and 
save a task. 

Database Changes  

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 
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Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.3.3.21 from the Deltek Software Manager to work with Cumulative Update #023 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager 

Cumulative Hot Fix 024 (June 27, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #023 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #024, please review their descriptions above in 
this document. 

Reporting/Billing 

Defect Tracking Number: 428859 

Description: The Fee Remaining report processed slowly. 

Impact: This issue affects Vision 7.1 and later releases. 

Workaround: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.ReportingBilling.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes 

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 
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Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.3.3.21 from the Deltek Software Manager to work with Cumulative Update 
#0023 or later. Additional details and documentation are available with the Connect for Microsoft 
Outlook download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 
before you install the hot fix. 

Cumulative Hot Fix 025 (July 11, 2014)  Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #024 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #025, please review their descriptions above in 
this document. 

Regulatory Updates 

State of Alaska 

The following updates were made to the Alaska geographic and occupational code drop-downs in 
Vision. 

Alaska Geographic Code 

The following geographic codes were updated: 

79 Yakutat, City & Borough 
86 Juneau, City& Borough  
87 Sitka, City& Borough  
88 Petersburg Borough 
90 Prince of Wales-Hyder Census Area  
96 Skagway Municipality  
97 Wrangell, City & Borough 

Alaska Occupational Codes 

The following occupational codes were updated: 

11-3051 Industrial Production Managers 
11-9111 Medical and Health Services Managers 
11-9121 Natural Sciences Managers 
13-1151 Training and Development Specialists 
21-1099 Community and Social Service Specialists, All Other 

The following occupational code has been removed: 

51-9199.03 Food Processing Workers, All Other 

Please see the Government Publication: ALASKA Occupational Coding Manual  
http://labor.alaska.gov/research/erg/occmanual.pdff for details. 
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State of Idaho 

The annual Idaho Tax Withholding amount has been increased to $3950. Please see the 
following for details: 

http://tax.idaho.gov/pubs/EPB00006_06-24-2014.pdf 

State of Ohio 

Percentage-method withholding tables, effective July 1, 2014, were released by the Department 
of Taxation. The table reflects a 1 percent reduction in withholding rates. 

See 
http://www.tax.ohio.gov/Portals/0/employer_withholding/July%201,%202014%20Tables/WTH_Pe
rcentageMethod_062014.pdf for details. 

An optional computer method was also released. 

See 
http://www.tax.ohio.gov/Portals/0/employer_withholding/July%201,%202014%20Tables/WTH_Op
tionalComputerFormula_062014.pdffor details. 

State of Oregon 

Vision now supports Oregon SUTA electronic filing. For details refer to: 

http://www.oregon.gov/EMPLOY/TAX/docs/magmedia0609.pdf 

GovWin IQ Integration 

The GovWin IQ integration has been updated to use SSL encryption. You must install this 
cumulative update in order to continue to use this integration in GovWin Capture Management or 
Vision after October 7, 2014. 

Info Center 

Defect Tracking Number: 430462 

Description: When you tried to send an email from Vision, you periodically received an “Invalid 
token for impersonation - it cannot be duplicated.” error. If you restarted Internet Information 
Services (IIS), the error was temporarily eliminated. 

Impact: This defect applies to Vision 7.3. 

Workaround: None. 

Additional Notes: None. 

Files Updated 
Deltek.Framework.SysEmail.Server.dll 

Other Applications Affected 

System File Dependencies 

Database Changes 

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 
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CONNECT FOR MICROSOFT OUTLOOK 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.3.3.21 from the Deltek Software Manager to work with Cumulative Update 
#0023 or later. Additional details and documentation are available with the Connect for Microsoft 
Outlook download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 

Cumulative Hot Fix 026 (July 25, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #025 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #026, please review their descriptions above in 
this document. 

Vision 

Deltek Defect Tracking Number:   435523 

Description: When you clicked the GovWin.com option on the GovWin Capture Management 
main toolbar, you received a "Page Not Found" error.  

Impact: This defect applies to GovWin Capture Management 7.1. 

Workaround: Use your browser to access http://govwin.com. 

Additional Notes: None 

Files Updated  
Deltek.Vision.FrameUI.Client.dll 

Other Applications Affected 

System File Dependencies 

API 

Deltek Defect Tracking Number:   436551 

Description: The Get*ByQuery calls failed when the "All" option was used for the last parameter. 
For example: GetProjectsByQuery. 

Impact: This issue applies to Vision 7.1 

Workaround: Use InfoCenterXML with the GetRecordsByQuery call. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected 

System File Dependencies 
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Human Resources / Payroll / Quarterly Processing 

Deltek Defect Tracking Number:  436590 

Description: The SUTA electronic filing for the state of Oregon incorrectly included carriage 
returns after each record. 

Impact: This issue applies to Vision 7.1 

Workaround: None. 

Additional Notes: None 

Files Updated  
Deltek.Vision.QTRMagMedia.Server.dll 

Other Applications Affected 

System File Dependencies 

Info Center / Projects 

Deltek Defect Tracking Number:  434084 

Description: When creating a project from a plan, the user-defined fields were set to empty 
string (blank) instead of null.  

Impact: This issue applies to Vision 7.1. 

Workaround: Update the field with sample data, save, delete then save again. 
For many records: update projectcustomtabfields set custuser = Null where custuser = '' 

Additional Notes: None. 

Files Updated  
Deltek.Vision.PlanProjOpp.Server.dll 

Other Applications Affected  

System File Dependencies 

Deltek Defect Tracking Number:  435987 

Description: When creating a project from a plan, the user-defined date field on the General tab 
of the Project Info Center defaulted to 1/1/1900 when a default date was not defined. 

Impact: This defect applies to clients using Vision 7.2. 

Workaround: Delete the date.  

Additional Notes: None. 

Files Updated  
Deltek.Vision.PlanProjOpp.Server.dll 

Other Applications Affected 

System File Dependencies 

Planning / Project Planning 

Deltek Defect Tracking Number:  436135 

Description: An error displayed when using the Create Project from Plan menu option on the 7.1 
CU server.  
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Impact: This issue applies to Vision 7.1. 

Workaround: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.PlanProjOpp.Server.dll 

Other Applications Affected  

System File Dependencies 

Database Changes 

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

CONNECT FOR MICROSOFT OUTLOOK 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.3.3.21 from the Deltek Software Manager to work with Cumulative Update 
#0023 or later. Additional details and documentation are available with the Connect for Microsoft 
Outlook download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com. 

Cumulative Hot Fix 027 (August 8, 2014) Removed. Included in 
Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #026 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #027, please review their descriptions above in 
this document. 

Reporting/Billing 

Defect Tracking Number: 436774 

Description: The Fee Remaining report processed slowly. 

Impact: This issue affects Vision 7.1 and later releases. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ReportingBilling.Server.dll 

Other Applications Affected  

System File Dependencies  



Hot Fix Descriptions as of October 17, 2014 

 

Hot Fix List 82 

 

Database Changes  

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com 

Cumulative Hot Fix 028 (September 19, 2014) Removed. Included 
in Cumulative Hot Fix #029 

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #027 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #028, please review their descriptions above in 
this document. 

 

Regulatory Updates 

State of Illinois 

Illinois SUTA Electronic Filing 

Starting July 2014, aside from quarterly files, the state of Illinois requires eight additional 
electronic monthly wage reports for employers with 25 or more employees. The files that contain 
the employer and employee data will be in a comma-separated (.csv) plain ASCII text format. 

Files Updated 

Deltek.Vision.QTRMagMedia.Server.dll 
Deltek.Vision.ReportLabels.Server.dll 
Deltek.Vision.pyFormQuarterly.Client.dll 
pyrptFormQuarterlyNE.rdl 
pyrptFormQuarterlyTX.rdl 

State of Nebraska 

Nebraska SUTA Electronic Filing 

Vision now supports Nebraska SUTA electronic filing. For details, refer to 
http://www.dol.nebraska.gov/employers/tax/FTPSpecs/FileSpec512.PDF 

Files Updates 
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Deltek.Vision.QTRMagMedia.Server.dll 
Deltek.Vision.ReportLabels.Server.dll 
Deltek.Vision.pyFormQuarterly.Client.dll 
pyrptFormQuarterlyNE.rdl 
pyrptFormQuarterlyTX.rdl 

State of Pennsylvania 

Pennsylvania SUTA Electronic Filing 

As of June 2014, the Employee First Name field (Record S, Positions 31-42) must not contain 
any spaces. 

Files Updated 

Deltek.Vision.QTRMagMedia.Server.dll 
Deltek.Vision.ReportLabels.Server.dll 
Deltek.Vision.pyFormQuarterly.Client.dll 
pyrptFormQuarterlyNE.rdl 

pyrptFormQuarterlyTX.rdl 

Database Changes  

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com. 

Cumulative Hot Fix 029 (October 17, 2014)  

 

This Hot Fix replaces and includes all prior updates from Hot Fix #001 and #028 and those Hot 
Fixes have been removed. However, if you previously installed a Hot Fix, it will still show up in 
the About Deltek Vision dialog box as being installed. For a description on what was fixed in 
the hot fixes that were consolidated into #029, please review their descriptions above in 
this document. 

Info Center/Projects 

Deltek Defect Tracking Number:  447475 

Description:  If you had a project with phases, and you added another phase using New » Copy 
Current Phase, the amounts on the Budget & Revenue tab of the original phase would be copied 
to the new phase. This would cause the compensation, consultant fee, and reimbursable 
allowance totals for phases to be out of sync with the same totals for the project as a whole. 
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Impact: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated  
Deltek.Vision.ProjectInfoCenter.Server.dll 

Other Applications Affected  

System File Dependencies  

Database Changes  

The following .SQL script (DeltekVision71GACU022.sql) must be run on each database to which 
this HotFix is being applied. You can either select the database on the screen, which will also 
make a backup of this, or you can choose to manually make a backup (by not selecting any 
database upon installation) and then run this script at a later time. 

Connect for Microsoft Outlook 

Connect for Microsoft Outlook users must download and deploy the latest Connect for Microsoft 
Outlook update 1.2.1.3 from the Deltek Software Manager to work with Cumulative Update #002 
or later. Additional details and documentation are available with the Connect for Microsoft Outlook 
download in the Deltek Software Manager. 

Custom Programs Affected 

Sometimes a hot fix can cause custom programs and reports to stop working as expected. Before 
applying this hot fix, consider whether you have any custom programs or reports in the 
application area affected by the hot fix. If so, contact Deltek support at http://support.deltek.com. 
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